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Pin-up is all about attitude – and I think 
you’ll agree that our sassy roller-derby 
cover star has it in spades. I loved 
working with artist Loopydave on this 
image, and I still smile at the little 
comedic touches that he added to the 
painting. See if you can spot them. Turn 
to page 58 to see how the artist created 

our heroine, and to find out who Skinny Al is… 
From page 46 we celebrate the artists behind the most beautiful 

female paintings in the universe. The usual suspects take a bow –  
step up Adam Hughes, Serge Birault and Sorayama to name a few, but 
there’s also some new artists bringing a fresh approach to the genre. 

Elsewhere, we delve into the world of tattoos. Tattoo art has taken a 
fascinating journey from being the outsider’s choice of rebellion, to 
being a recognisable art form. Find out more about this permanent 
art exhibition on page 20. Oh, and have you had a tattoo done of your 
favourite artist’s work? Or got a tattoo of a piece of art from the pages 
of ImagineFX, perhaps? Let us know! Send in your photos and tell us 
why you had to have something forever adorned on your body.

As always, let me know what you think about this edition – my 
email address is below. I might not be able to respond to you all, but  
I always love hearing your views, so drop me a line to share your 
thoughts and tell me about the art you created after being inspired by 
what you’ve seen on these pages.

Editor’s letter
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Our special cover for 
subscribers this issue.

to a cracker of an issue
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Portray a  
sassy pin-up
Loopydave explains how he paints a 
roller derby player. And meet Skinny 
Al, the skull that adds a storytelling 
element to the composition.
Plus WIPs and final image

Resources

February 20146 February 2014

Getting your hands on all of this issue’s essential 
resources is now easier than ever. Just go to our 
dedicated web page at http://ifxm.ag/oolala105

Resources

1Go to the website
Type the URL into your address 

bar: http://ifxm.ag/oolala105.

2Find the files you want
Search through the list of 

resources to watch or download.

3Download what you need
Click the asset download button 

or watch the videos online!

HOW TO GET 
YOUR FILES
How to find the video and 
workshop files in three 
simple steps…

COVER VIDEO

of workshop and Q&A video to watch and  
learn from!

OVER  6 HOURS 



Fiona Meng
Enter this artist’s melancholy world and see 
her soft painting technique in action.
Plus WIPs and final image

Goñi Montes
Discover how to give your pin-up figure 
perfect-looking skin.
Plus WIPs and final image

Nadia Enis
Here’s what you need to know about 
drawing a male pin-up character.
Plus WIP and final image

Nadia Enis
Push the anatomy of a pin-up character to 
make the composition more interesting.
Plus WIP and final image

PLUS Extensive WIPs, brushes and final artwork from Matt Dixon, Serge Birault, Jace Wallace, Tony Foti, Waldemar Kazak, Ien Levin, 
James Zapata, Guillaume Poux, Kev Crossley and Chris Legaspi.

EXCLUSIVE VIDEO TUITION!
Watch our videos to gain a unique insight into how our artists create their stunning art

14 CUSTOM BRUSHES, INCLUDING…
CHRIS WAHL BRUSHES 
This was the brush that Guillaume Poux 
used for his figure’s Afro hair style.

BRUSH_1 
Therese Larsson finds this brush 
closely mimics traditional media.

CUSTOM BRUSHES 
Use other artists’ brushes but vary 
their use, suggests Geoffrey Ernault.

Geoffrey Ernault
Boost your Photoshop brush skills and 
create an image from random strokes.
Plus WIPs, brushes and final image

James Gurney
Watch a clip from the Dinotopia artist’s 
latest project, in which he paints a series of 
stamps for the Australian postal service.

Therese Larsson
Learn how to add humour to a storybook 
illustration, through body language.
Plus WIPs, brushes and final image

Issue 105 February 2014

February 2014 7

Q&A VIDEOS

WORKSHOP VIDEOS

VIDEO SAMPLE



8 February 2014 FXPosé submissions to: fxpose@imaginefx.com

THE PLACE TO SHARE YOUR FANTASY ART

1EXOSUIT “This is my most recent 
work. I used my library of 

3D-modelled mechanical parts, much 
like kitbashing in Maya. Then I rendered 
in it Keyshot, with a simple matte 
painting as a backplate. I then put 
everything together in Photoshop. Fun!”

2RAPTURE “This was done for 
Dominance War IV’s concept art 

challenge. Rapture is the demon lord of 
death, the herald of the apocalypse. This 
chap’s more like an event or disaster 
than a creature.”

358TH “I’m a huge fan of Games 
Workshop’s Warhammer 40,000, 

and this is a tribute to Death Korps of 
Krieg, 158th Siege regiment, produced 
by Forge World. It was painted in 
Photoshop and I used some World War 
One photos as reference.” 

4NET “The theme of this painting is 
‘digital hell’. It was created for an 

exhibition, but was never shown.”

1

2 3

ARTIST OF THE MONTH
Congratulations, Volkan – you’ve won 
yourself a copy of Exposé 11 and 
d’artiste: Character Design! To find out 
more about these two great books, go 
to www.ballisticpublishing.com.

Volkan Kucukemre
LOCATION: Turkey
WEB: vkucukemre.deviantart.com  
EMAIL: vkucukemre@gmail.com 
MEDIA: Maya, ZBrush, 3D-Coat, 
Keyshot, Photoshop, PaintTool SAI

Founded in 2009, 
Gamester is one of Turkey’s 
first ever gaming startups. 
The Istanbul-based studio 
is home to Volkan, who’s 

responsible for artwork and asset 
development, as well as game design.

The graphic design graduate is not 
only passionate about traditional and 
digital art, but also enjoys building plastic 
models and wargaming miniatures.  

“I don’t feel like I’ve developed a style 
of my own,” Volkan says. “Instead, I draw 
inspiration from various sources as I’m 
working. Sci-fi and fantasy are really 
exciting to me.”
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Concept artist Fred Augis appreciates 
the work that’s gone into Volkan’s mech

“Volkan has a good eye for robots. 
Their poses give them an aggressive 
feel. The matte shades fit the setting to 
give it a sense of harmony throughout.”

4
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1POISON GIRL “The title is borrowed 
from Angelique Houtkamp’s painting 

of the same title. I love the original and 
wanted to recreate it with own my 
personal twist.”

2RYE THE ADVENTURER “Here, I was 
trying for a much more cartoon-like 

style, without going overboard with 
colour and line-art. I really like the 
outcome, and plan on playing around 
with this style.” 

3THE WHITE DUCHESS “The idea 
was to paint a portrait of a villain 

(hence the eye patch), something you’d 
imagine the subject hanging above their 
mantle. Most of all, I love the dress.”

Elin Lindehoff 
LOCATION: Sweden
WEB: www.elinlindehoff3d.com
EMAIL: lindehoff@hotmail.com
MEDIA: Photoshop

“I love exploring new styles 
while still retaining a look 
of my own,” Elin says.  
“I think you can grow stale 
committing to one 

particular style. If I don’t change up the 
way I draw, every couple of months or 
so, I end up bored.” 

Elin is an illustrator turned student of 
game development. She attends the 
Game Assembly, a vocational college in 
Malmö. As part of her course, the Swede 
is a member of the graphic team behind 
six fully functioning short games. 

1

2 3

IMAGINEFX CRIT
“Elin has an 
interesting approach 
to art, regularly 

switching styles to keep 
things exciting. The 
common theme in these 
works – and one I like – is 
subjects with bags of 
character, in settings full 
of interesting subplots.” 
Gary Evans,  
Staff Writer
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1GREAT WHITE “I’ve always loved 
great white sharks and their almost 

mythological status. I wanted this one to 
evoke either fear or a sort of peaceful 
symbiosis between man and shark. How 
you perceive it depends on your attitude 
towards sharks, I guess.”

2FORTRESS OF SOLITUDE “This was 
my first proper attempt at matte 

painting. The inspiration was a photo my 
brother took of a guy standing on a hill. 
“He looks like Superman standing there 
like that,” he said. So I did this.” 

3BOBA FETT: BOUNTY HUNTER 
“This Star Wars character has always 

been my favourite – well, since Empire, 
anyway. He was the ultimate in cool and 
the inspiration behind countless bad-ass 
characters since.”

Andy Fairhurst 
LOCATION: Wales
WEB: www.andyfairhurstart.com 
EMAIL: andyfairhurst72@hotmail.co.uk  
MEDIA: Photoshop

Andy is an English 
freelance digital painter 
who’s living and working  
in Wales. The artist has a 
diverse portfolio that 

covers everything from character design 
and portraits, to matte painting and 
logos. Ballistic Publishing has featured 
his work in Exposé, Exotique and 
d’artiste Fashion Design. 

Andy’s currently working on a range 
of Doctor Who products with UK-based 
BIG Chief Studios Ltd. And proving what 
an all-round multidisciplinary talent he 
is, Andy is also putting the finishing 
touches to promotional artwork for the 
children’s novel he’s penned. 

1

3

2
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1DON’T EVEN THINK ABOUT IT  
“I wanted to reinterpret the classic 

theme of the beauty and the beast in a 
sharp and ironic way. I worked a lot  
on the expression of the protagonist’s 
face, because I wanted it show her 
tough personality.” 

2EROS AND THANATOS “I like to 
draw big bad demons, and I also like 

to draw female characters. So, I decided 
to play around with the contrast 
between these two figures, emphasising 
differences as much as possible.”

3THE SACRED FEATHER “This is the 
cover for a fantasy book written by 

Matthias Graziani. I really like it when  
I have the opportunity to draw beautiful, 
strong women.  But in this case, the 
female character also had to have a very 
sweet face.”

4DIANA “My interpretation of the 
Roman goddess Diana. I didn’t want 

it to stay too true to the myth, but I did 
want to capture her wild characteristics.”

Sara Forlenza  
LOCATION: Italy
WEB: www.saraforlenza.com
EMAIL: contact@saraforlenza.com
SOFTWARE: Photoshop, Painter

Sara was originally 
attracted to traditional 
media, particularly acrylics. 
But the Bergamo-based 
artist found she couldn’t 

express herself in the way she’d like. 
Inspired by artists such as Todd 
Lockwood and Matt Stawicki, she turned 
to digital painting. 

Each stage of Sara’s artwork is 
created digitally – including sketches, 
for which she uses her Cintiq. The artist 
has developed a clean, sharp style 
redolent of the Blizzard illustrations  
that she finds so inspirational. Sara’s 
been working as a freelancer since 
2006, finding clients in the likes of  
Paizo Publishing, Dena Studios and 
Armenia Editore.

1 2

3
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IMAGINEFX CRIT
“With a colourful 
and clean style,  
Sara is equally 

comfortable painting 
explosive action or delicate 
woodland scenes, and her 
secret is using colour tones 
to evoke a different feel  
in each piece.” 
Beren Neale,
Digital Editor

4

mailto:fxpose@imaginefx.com
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1FELL RUINS “This was one of my first 
digital paintings. I was trying to 

create a moody, mist-filled fantasy 
location, while still getting to grips with 
the digital process. It was a huge 
learning curve.”

2WISDOM “This was a personal piece 
in which I explored a more painterly 

style. I used lots of textured brushes 
balanced with very delicate strokes to 
capture the facial features.”

3VENICE “From a young age, I’ve 
always loved Canaletto’s paintings 

of Venice. Architecture is a passion and 
Venice is full of beautiful buildings. But, 
at the same time, Blade Runner and 
apocalyptic science fiction have always 
equally enthralled me. This was a fun 
blend of them all.”

Meg Owenson 
LOCATION: England
WEB: www.lastsiren.com
EMAIL: megan.owenson@gmail.com
SOFTWARE: Photoshop

Meg is a fine-arts graduate. 
Around a year ago, 
however, she was seduced 
by digital painting. She 
loves the versatility, the 

speed at which she can realise an idea.  
“My goal,” Meg says, “is to create 

immersive worlds that capture the 
viewers imagination. I include as many 
little details as possible. This, in my 
opinion, is what makes locations and 
characters come to life.”

Meg’s influences range from Albert 
Bierstadt to Samuel Taylor Coleridge. As 
a professional artist, her work covers 
card art, book covers and private 
commissions, with one eye on branching 
into the film industry.

IMAGINEFX CRIT
“Meg’s experiment 
with a painterly 
style is a lovely piece 

of character art. I find 
myself asking, ‘What’s this 
old chap’s story?’ Perhaps 
he’s spent a lifetime 
travelling along the 
dangerous waterways of 
futuristic Venice…” 
Cliff Hope,
Operations Editor

1

3

2
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1GYPSY’S VOODOO “A gypsy is 
suffering from a long-standing love 

obsession, only to realise that it wasn’t 
the right thing for her. So she decided to 
kill her feelings using voodoo.”

2ISIS “This is my personal version of 
my favourite Egyptian goddess.”  

3MEDUSA’S GRIEF “This is a tribute to 
a dear friend of mine. Most people 

portray Medusa as a wicked, evil witch 
who turns her enemies into stone. But I 
always felt that she had a different side. 
Her grief at turning everyone she looks at 
into stone makes her lonely and fragile.”

Dahlia Khodur
LOCATION: Lebanon
WEB: http://ifxm.ag/dkhodur
EMAIL: dahliakhodur@gmail.com
SOFTWARE: Photoshop, Poser

Dahlia believes in a 
multidisciplinary approach 
to creativity. Primarily an 
illustrator, her output also 
spans logo and graphic 

design, digital art and animation, all 
done using various media and styles. 

Khodur strives to come up with 
“original and imaginative designs and 
characters.” There’s no secret to 
achieving this, she says. No shortcut. It’s 
about putting the hours in. 

“I work very hard,” the Lebanese 
artist says. “I learn new techniques 
everyday. My goal is to make my 
characters feel alive, and to one day 
break into the video game industry.”

1

2

3
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1DARK FOREST “Soldiers dare to 
enter a dark forest where no one has 

ventured for a long time.”

2THE PREY “This painting features 
three characters: a snake, a woman 

and something sneaking up to them.”

3BATTLE RHINO “A female warrior 
rides her heavy rhino, about to 

engage in an epic fight.” 

4HOME SWEET HOME “I wanted  
to depict victorious warriors 

returning from a battle.”

Camille Alquier
LOCATION: France
WEB: http://caam.ultra-book.com
EMAIL: alquier.camille@gmail.com
SOFTWARE: Photoshop

Photo integration, textures, 
custom brushes: these are 
the tools of Camille’s trade, 
everything he needs to 
create his “own heroic 

fantasy universe.”
It’s a universe filled with flying 

dragons and mutant rhinoceros, one 
rendered with an eye for unique 
composition and deft lighting. 

Camille is not only an exponent of 
digital painting, but also teaches it at a 
local art school in his native Bordeaux. 
His lessons are all about, “sharing 
techniques and expertise with 
students.” His influences include Vicente 
Segrelles, Olivier Ledroit, Kekai Kotaki 
and Craig Mullins, to name just a few. 
He’s clearly a versatile artist, and one 
whose portfolio we recommend you 
spending some time flicking through. 

1

32

IMAGINEFX CRIT
“Camille has put 
together some 
beautifully lit  

scenes here, each with  
a majestic sense of scale.  
I especially like how the  
light bounces off the 
returning heroes in  
Home Sweet Home.” 
Claire Howlett,
Editor
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1THE JOURNEY BEGINS “This year  
I took James Paick’s environment 

design class at CGMW. This was my final 
piece, in which I applied everything I’d 
learned throughout the workshop. It’s 
also the prequel to The Journey’s End 
that I’d wanted to do for years.”    

2THE JOURNEY’S END “I created this 
illustration for a ConceptArt.org 

Illustration of the Week challenge a few 
years ago. The theme was Journey’s 
End. I spent the weekend before the 
challenge watching The Lord of the 
Rings series, which was a big influence.” 

3DER GOTT DER XO’ARTA “A cover 
illustration I did for a pen and paper 

adventure that’s part of The Dark Eye 
RPG. In this case, the brief already 
defined what I had to illustrate and any 
similarities to The Lord of the Rings are 
merely coincidental.”

Nele Klumpe
LOCATION: Germany
WEB: www.nele-klumpe.de
EMAIL: nele.klumpe@gmx.de
SOFTWARE: Photoshop

Nele was featured in 
FXPosé way back in 2008. 
Since then, a few well-
chosen words of 
encouragement from her 

peers have helped her hone her craft.  
“I started studying design,” she says. 

“During that time my art skills were still 
pretty bad. I didn’t know how to 
improve until a few fellow artists 
inspired me to start working harder.”

It’s clearly paid off. Nele is now 
employed full-time as a designer but 
continues to illustrate on a freelance 
basis, sketching every day during her 
commute to work. Her ambition is earn  
a living drawing fantasy art.   

1

2 3
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1VEGETOPIAIRE “These kind of top-
down views are a way to reveal a lot 

about a world. This one was done for a 
project set during the Renaissance.”

2KIKIDONC COULEUR “I alway think 
of the real title of piece as being 

Happy Humanist.” 

3SANDRA’S WORKSHOP “A view of 
the interior of Sandra’s workshop, a 

character from a personal project.” 

4THE TRUSTY STEED “This personal 
illustration plays with the idea of  

a child being able to achieve great 
things. I find the Jeanne d’Arc theme 
pretty inspiring.”

Thomas Brissot
LOCATION: Singapore
WEB: www.thomasbrissot.com
EMAIL: thomasbrissot@gmail.com
SOFTWARE: Painter, Photoshop

Thomas’s passion for art 
has led him around the 
world. He honed his 
drawing, painting and 
modelling skills at L’Atelier 

de Sèvres in Paris. From there, he moved 
on to another French art school, ESAD in 
Strasbourg. But the course wasn’t as 
he’d imagined. 

“I learned how to talk about the 
subject,” Thomas says, “without ever 
actually doing any drawing or painting 
anything.” He left, in 2008, and fell into 
“a lot of boring advertising jobs and 
uninteresting illustrations to pay the 
bills.” But the artist had built a portfolio, 
mainly consisting of personal projects, 
that would lead to more interesting 
opportunities.

Thomas is now in the “very exciting 
and inspiring” position of being a 
teacher and senior concept artist at  
FZD School of Design in Singapore. 
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IMAGINEFX CRIT
“I love how The 
Trusty Steed has 
been inspired by the 

story of Jeanne d’Arc. The 
clever use of space, small 
background elements and 
the proportions of the 
knight really exaggerate 
the stature and power  
of the steed.” 
Daniel Vincent,
Art Editor



Send up to five pieces of your 
work, along with their titles, an 
explanation of your techniques, a 
photo of yourself and contact 
details. Images should be sent as 
300DPI JPEG files. 

Email: fxpose@imaginefx.com 
(maximum 1MB per image) 

Post: (CD or DVD):  
FXPosé
ImagineFX
30 Monmouth Street
Bath 
BA1 2BW, UK

All artwork is submitted on the 
basis of a non-exclusive 
worldwide licence to publish, both 
in print and electronically. 

SUBMIT YOUR 
ART TO FXPOSÉ

19FXPosé submissions to: fxpose@imaginefx.com February 2014
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“The days of scruffy walk-in tattoo 
parlours are numbered,” says Gastown 
Tattoo Parlour’s Matt Houston. “They’ve 
largely been replaced by custom 
studios with specialised artists.”

“I find it’s such an honour that 
people let me permanently 
alter their bodies,” says tattoo 
artist Myke Chambers. 

An intricate and elaborate tattoo by  
the hand of London-born, Vancouver-
based tattoo artist Matt Houston. 

“is something that’s pretty much nonexistent 

now: I loved that it was the part of the 

underbelly of society and the art world.  

I started tattooing around 20 years ago and  

it was still mostly underground and taboo.”

The tattoo artist now has almost half a 

million likes on Facebook. He describes his 

style as traditional with a strong Americana 

influence. Home is the Northern Liberty 

Tattoo studio in Philadelphia, but he 

continues to travel the world tirelessly. His 

appointments at festivals and conventions 

are snapped up instantly. 

STREET ART
Growing up in notorious east Los Angeles, 

his first memories of tattoos were on 

members of street gangs. While Myke 

himself embodies the kind of outlaw 

character historically associated with 

tattoos, he says ink’s image has changed 

drastically in recent years.

“Only bikers, gang members and 

servicemen were getting tattooed,” he says. 

“Tattooing has been catapulted into the 

mainstream by celebrity tattoos, reality TV 

and tattoo publications. They all make it 

more acceptable. Seeing someone with a 

tattoo was once rare, but now you can’t walk 

to a corner store in any city without seeing 

at least one tattooed person.”

Others argue tattoos were seen as 

civilised long before the 21st century.  

Dr Matt Lodder, an art 

historian specialising in the 

history of tattooing as an 

artistic practice, points to a 

January 1926 Vanity Fair 

Myke Chambers would tattoo 

his fellow prisoners using  

a makeshift machine fitted 

with hand-wrapped coils and 

hand-sharpened needles.  

It was powered by his clock radio. 

Having left home at 15 – on the run after 

an armed robbery – he lived hand-to-mouth 

hopping freight trains around the US with his 

little brother Stevie. He began his tattooing 

apprenticeship in New Orleans. But an 

itinerant existence, escalating drink and drug 

problems, exacerbated by the death of 

Stevie, and his criminal past eventually 

caught up with up him.

After four years in a Texas penitentiary, 

and after beating his addictions, Myke had 

to learn his craft all over again. He’d spent 

too long “tattooing high”, he says. “What 

first attracted me to tattooing,” says Myke, 

Body of work From the underclasses to the masses via  
Winston Churchill: we chart the art history of ink on skin

ARTIST NEWS, SOFTWARE     EVENTS

AT THE CORE OF THE FANTASY ART COMMUNITY
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How did you get into tattooing?
I used to work white-collar 
corporate jobs, busting my balls 
getting little buzz out of life.  
My apprenticeship, at a studio  
in London, was undertaken 
voluntarily and without pay.  
I worked for nearly two years 
unpaid before being regarded as 
qualified. I quit a top design job 
with a global blue chip to take my 
first chair. It was scary at first, but 
I’ve never looked back. 

What are the best and worst 
things about being a tattoo 
artist today?
I love the challenges tattooing 
presents and the satisfaction it 
offers. You get out what you put in. 
I wanted to learn and wanted to 
work hard. Primarily it was the art 
that drew me to the job, but also 
the learning. I love the fact that 
every day is totally different, 
meeting new people and 
encountering new projects. I have 
also found that fellow artists are 
just people. Reality TV programmes 
paint us as 24-hour party people, 
but most artists I know couldn’t 
keep up their tremendous work 
efforts if that were true. 

What should be taken into 
consideration before getting  
a tattoo? 
When I design a tattoo I try to 
consider how it will look in 20 
years or more. I want my tattoos to 
last and look good forever. I design 
tattoos that are simple and elegant, 
but retain a bespoke look. An artist 
colleague told me that when one 
designs a tattoo it’s a mathematical 
equation that needs to be solved: 
how can I equate the elements a 
customer wants in a way that is 
aesthetically pleasing and stands 
the test of time?

INDUSTRY INSIGHT

MATT 
HOUSTON

Gastown Tattoo Parlour’s  
rising star talks tattooing

Matt began tattooing in 2008. 
Looking for his first tattoo, he 
took his design into a shop and 
was offered an apprenticeship. 

www.gastowntattoo.com

  Ötzi the Iceman, a man 
who lived over 5,000 years 
ago, was found to have more 
than 50 tattoos 

EVERWINTER 
IS COMING
A boyfriend-and-
girlfriend duo has 
collaborated on a new 
children’s fantasy book, 
where the artwork 
changes according to 
the story’s mood.   
Page 24

CHILD’S  
PLAY
Motherland Chronicles 
is an ambitious 
collaborative – and 
weekly – project 
between photographer 
and artist, inspired by 
the former’s childhood. 
Page 25

A SMALL 
WORLD
Every inch of Will 
Murai’s small but stylish 
São Paulo workspace  
is designed to inspire 
his art – he needs it as 
he often works long 
into the night.
Page 26

Dark imagery with 
fantasy elements, like 
this piece, are a 
speciality of San 
Francisco-based tattoo 
artist Jason Donahue. 

Princess Leia by Myke Chambers, who works at 
Northern Liberty Tattoo in Philadelphia. 

“My heroes are my 
clients,” says Myke 

Chambers. “The 
world is my gallery.”

report which says: “Tattooing has passed 

from the savage to the sailor, from the sailor 

to the landsman. It has since percolated 

through the entire social stratum… and may 

now be found beneath many a tailored 

shirt.”  Matt says there’s been no wholesale 

change in the status of tattoos in recent 

years. It’s the aesthetics that have changed. 

SOCIAL SKIN
It’s rumoured Winston Churchill was 

tattooed. His mother definitely was. Tattoos 

were fashionable in Victorian London, with 

society girls and aristocrats. And many 19th-

century European royals had tats – inspired 

by the dapper future King Edward VII.

It’s true that ink was particularly popular 

with outsiders, misfits and miscreants. By 

the late 1800s, 90 per cent of the British 

Navy was tattooed – a turtle signified you’d 

crossed the equator, an anchor the Atlantic. 

Bikers and criminal gangs adopted their own 

iconography. But you can trace tattoos 

lineage back even further. 

Explorer James Cook, in the 18th century, 

returned home with drawings of what the 

Polynesians called a “tatau”. Julius Caesar 

was a fan of tattoos found on the Picts –  

the inhabitants of northern Britain during 

Roman times, whose name literally means 

“the painted people”. There have been 

stunning examples of body art found among 

ancient civilisations in Egypt, Asia and 

beyond. Tattoos served many purposes, 

from status symbols to warding off evil 

spirits, for punishment and for their 

perceived healing powers. 

Perhaps the most startling discovery in 

the history of tattooing was found on Ötzi 

the Iceman – a well-preserved natural 

mummy of a man who lived over 5,000 

years ago, and who was found to have more 

than 50 tattoos. 

“Tattooing and its coincident practices 

are a constant feature of all cultures  

on Earth,” Matt says. “There has always 

been, and will always be, a group of people 

driven inexorably to permanently mark  

their bodies.”

He argues the relative percentages of 

people with a tattoo – “about 30 per cent or 

so have at least one tattoo” – hasn’t changed 

much in 20 years ago. The change, he says, 

is more to do with visibility, both in terms of 

location of tattoos on the body – hand, neck, 

face – and an increase in the “display of 

naked flesh in public”.
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“Since the late 90s,” continues Matt, 

“UK trends have moved from tribal, through 

traditional, into black and grey and now to 

very stark, graphic, black tattooing – almost 

prison-esque. We’re probably due a revival 

of large blackwork. There are some 

incredible artists, such as Tomas Tomas  

at Into You, doing this remarkable avant-

garde digital tribal work – which I think will 

soon catch the attention of the fashion-

hungry youngsters currently into smaller 

blackwork pieces.”

Once you have whichever style of tattoo 

is in vogue, chances are, like Matt, you won’t 

stop there. University of Westminster 

psychologist Dr Viren Swami, who’s 

conducted extensive studies of people with 

tattoos, found most wait between two and 

seven years before getting their second 

tattoo. The trend for a more discerning 

tattoo-buying public mirrors a change  

in the demographic of those getting  

into tattooing. 

Myke Chambers suggests the recent 

“quantum leap in tattooing’s evolution” is 

down, in part, to an influx of art school 

graduates into the industry – those artists 

who found work hard to come by after 

graduating and turned to tattoos. It’s one of 

the few artistic endeavours that can pay 

relatively well from the get-go. But the 

transition from more traditional forms isn’t 

necessarily a simple one. 

Jason Donahue works at 

Idle Hand in the Lower Haight 

district of San Francisco. He 

says many tattoo artists paint 

with watercolours or liquid 

acrylics, as they best relate to tattooing.  

“I approach a watercolour just like a tattoo,” 

he says. “Black outline, black shading, then 

colour. Every tattoo starts as a line drawing 

on paper, so every tattooer must first be a 

good illustrator. I think there are so many 

bad tattooers out there because people 

start tattooing before they really even know 

how to draw.” 

ARTISTIC CROSSOVER 
Jason also points to a crossover with 

sculpture. Tattoo artists need to think three-

dimensionally, designing and placing tattoos 

that’ll work with and complement human 

anatomy – especially when you get into 

large-scale tattoos. 

“Being a skilled artist is no guarantee 

you’ll make a good tattoo artist,” says Jason. 

“It’s a highly technical medium, so it takes a 

certain type of person. You need to be 

artistic as well as mechanically inclined. 

You’re also dealing with blood, so you need 

training in blood-borne pathogens and 

cross-contamination.”

Jason thinks tattooing’s rise in popularly 

– or at least rise in visibility – is good. And 

despite conceding he does miss the days 

when the form was a little more taboo, 

there’s no other profession he’d rather be in. 

“I love everything about tattooing. I get to 

draw for a living. I love hanging out in the 

tattoo shop. My co-workers are also my best 

friends. The shop is like our clubhouse. I love 

all my clients and am honoured every time 

someone chooses me to do their tattoo.  

I love that what I do makes people happy. 

Just the fact that tattooing is possible is 

what always attracted me to it. It still blows 

my mind that you can put a picture in your 

skin, and it will stay there forever.” 

ImagineNation News

  Every tattoo starts as a line drawing 
on paper, so every good tattooer must 
first be a good illustrator 

Myke Chambers’ 
nightmarish vision of 
Moby Dick is part of  
the rich, long-standing 
tradition of storytelling 
in tattoos. 

Artist such as Ed Hardy 
and Thom Devita paved 
the way for tattooing as 
an art form, says Idle 
Hand’s Jason Donahue. 

Tiger Lady by Myke Chambers, who describes  
his Americana-inspired style as traditional.

Matt Houston, the 
artist behind this 
piece, says diplomacy 
is key to ensuring 
clients get what they 
want – but also 
getting something 
they won’t regret. 

“Tattooing will always be a little 
more craft than art,” says Jason 
Donahue, “because, as a tattooer, 
there’s only a little room for 
personal expression.”
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CAVE attendees were 
asked to submit short 
character descriptions 
and vote for the best 
three. They were then 
drawn by pro artists. 
Bobby Chiu sunk his 
teeth into this one! 

Syd Mead put  
in a rare appearance, 

and an even rarer 
process breakdown  

of some of his art.

Lena Le drew this composite 
CAVE-inspired digital painting, 
which provided a backdrop to Chris 
Cheung’s introductory talk.

Shine a light: the first CAVE 
conference kicked off in the 
not-so-dark Las Vegas.

Calum Alexander Watt drew this  
painting over the two-day convention, 

based on an attendee’s suggestion.

Out of the darkness

The dust has settled on 

Autodesk’s first CAVE 

conference, and Chris Cheung, 

the mastermind behind it, is 

finding it hard to explain 

what exactly just happened. 

Ostensibly it was the first creative event 

to run at the front end of the business-driven 

Autodesk University Conference, in Las 

Vegas’s grand Venetian hotel on 1-2 

December 2013. It was also Chris’s personal 

Inspired Digital artists and inspirational figures unite 
in Las Vegas for Autodesk’s first CAVE conference

  I would have gone to an 
event like this if it had existed 
when I was starting out 

attempt to offer digital creatives something 

uniquely engaging, whatever their field.

“After the success of SketchBook Pro, 

people formed communities. That led to 

smaller talks when people like Scott 

Robertson or CB Cebulski were in town,” the 

Autodesk product line manager explains. 

“Even though people had seen these guys at 

comic conventions, they never really 

connected with them on an intellectual level. 

That seemed important.”

From the pre-event party 

where ticket holders saw  

John Cleese, Neil Gaiman,  

deviantART CEO Angelo 

Sotira and Bobby Chiu trading 

stories over drinks, the spirit of the event 

was set as open and inclusive.

Lorne Lanning’s opening seminar covered 

his “lifelong fascination with 

corruption and irony” mixed 

with entertainment in his 

Oddworld game franchise.

Neil Gaiman spoke of the 

power of understanding one’s imagination. 

“It’s enormously important,” he told 

ImagineFX. “This is the stuff people don’t tell 

you. I was lucky because I had punk and the 

attitude of ‘you do something by doing it’. 

That fuelled me. But passing that on to 

another generation is extremely important.  

I would have gone to an event like this if it 

had existed when I was starting out.”

Before the finishing party in the hangar-

sized main hall, Monty 

Python’s John Cleese was still 

making final tweaks to his 

speech, admitting to 

ImagineFX that, “I’d much 

rather speak at a seminar like this, to open 

minds, than shoot a film.” While Python fans 

will no doubt wish for the latter, a growing 

number of digital creatives should be 

looking to Chris’s next CAVE experiment.

Discover more about Autodesk CAVE 

here: www.autodeskcave.com.

Artist news, software & events
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Just finished something you want us to shout 
about? Send it our way on Twitter 
(@imaginefx), or find us on Facebook! 

Your art news that’s 
grabbed our attention

 Sergio Lopez 
(@Mainloop) 

“This new piece is 
Study for Parhelia… for  
an upcoming show.” 
http://ifxm.ag/sergio-lopez

 Nick Veez  
(@nickveez)

“Loving the latest 
edition guys. Your 
traditional art section 
inspired me to have a go.”
http://ifxm.ag/nick-veez

 Charleen Pardue 
(@toxxic_lady)

“Another #WIP. One of 
these days I will actually 
finish something… 
hopefully this one, today.”
http://ifxm.ag/charleen-pardue

Hatboy
by Vaughn Pinpin
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Artist Matthew Hill  
wore dreadlocks and 
earrings in his youth, 
not unlike one of the 
book’s main characters. 

The illustrative style  
in The Legend of 
Everwinter varies 
from scene to scene, 
based on the 
unfolding action. 

Fantasy talk Explaining the inexplicable
“Ever opened a canvas in Photoshop and been overwhelmed  
by the sheer emptiness of the big white rectangle?“
James Zapata boils down the complexities of artist’s block into a simple geometric shape… Page 66

A winter warmer

A boyfriend-and-girlfriend duo from the 

UK has collaborated on a new children’s 

fantasy book. The Legend of Everwinter, 

by author Tara Behan and illustrator 

Matthew Hill, tells the story of three 

friends on a journey to fulfil an ancient 

prophecy in a faraway land. 

Inspired by Harry Potter 

and The Lord of the Rings, 

with a nod to Disney films, 

Matthew says his biggest 

Hairy tale How a haircut helped inspire 
the hero of a new children’s book 

challenge was to create a book visually 

sophisticated enough for adults to enjoy, 

and colourful and fun enough to capture 

children’s imagination.

“I decided to vary the style of each 

illustration in relation to the mood of the 

story,” Matthew says. “When something 

sinister is taking place, the artwork becomes 

muted and realistic. When something 

pleasant is taking place, the artwork 

becomes much more stylised and colourful.”

Work began on the book back in autumn 

2012, but it wasn’t until the final few months 

of production that its overall appearance 

was finalised.

One of the book’s central characters is 

inspired by Matthew’s appearance in his 

younger days, when he had dreadlocks and 

pierced ears. And it may not be the last 

we’ve seen of the protagonist, with more 

tales from Everwinter in the pipeline.  

“I’m sworn to secrecy regarding this 

matter,” Matthew says. “But I can say 2014 is 

looking very promising.”

The Legend of Everwinter (£3.99) is out 

now. For more information and to order your 

copy visit www.hamptonbond.com. 

ImagineFX readers can receive a 20 per 

cent discount by using the code ‘tarabehan’. 

ImagineNation News
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Hitting the motherlode

Motherland Chronicles is a 

collaborative artbook by 

New York-based 

photographer Zhang Jingna 

and artist Tobias Kwan. 

The project was conceived as a platform 

for Jingna, who began working 

professionally for Harper’s Bazaar when she 

was just aged 20, to revisit the things she 

loved as a child – specifically fantasy art, 

anime and manga. 

For the project she’s teamed up with 

Tobias, a concept artist working at 

Californian video game developer Ready at 

Dawn, because, she says, “having a partner 

is infinitely more fun and exciting than doing 

a project alone”. 

Maternal instincts Two very different creative  
types join forces on a unique new artbook

The result is a collection of mesmerising 

otherworldly images, which have so far been 

featured in My Modern Metropolis, the 

British Journal of Photography and Vogue. 

“Jingna focuses on portraits,” Tobias says. 

“So I wait for previews from 

her shoot before starting on a 

piece to match her characters 

and provide more context 

within the environments.” 

The ambitious collaboration sees the pair 

create new artwork every week, leading to 

the release of a book in summer 2014. 

Motherland Chronicles includes a stellar 

line up of guest artists, such as Naomi Chen, 

cellar-fcp and Noah KH. Find out more at 

www.motherlandchronicles.com.

Created by artist 
Tobias Kwan, Bunny 
Yaga is the 18th piece 
in the Motherland 
Chronicles series. 

The Chronicles 
creates and publishes 
a new piece weekly, 
the 38th release 
being Tobias’s Rider. 

“Critiques of your 
work from someone 
working in a different 
medium are really 
cool,” Tobias says.  
“It gives you a  
fresh perspective.”

“The process of world and 
character-building and 
research makes this project 
collaborative,” says Zhang. 

In the Secret Garden 
sees photographer 
Zhang Jingna revisit her 
childhood inspirations. 

Artist news, software & events
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chose this great two-storey apartment near 

one of the busiest areas in the city, two 

blocks from Paulista Avenue. It’s surprisingly 

quiet for such a busy, inner-city area, 

though. And we have everything we need 

nearby: subway stations, shopping malls, 

museums, as well as restaurants and bars.  

I also wanted to live within walking distance 

of the office so I could avoid the infamous 

São Paulo traffic jams.

Here are some of the many gems we 
found on the pages of deviantART…

+deviantWATCH

Back in 2007, a world-

leading game publisher 

hired me as a 2D artist for 

its São Paulo branch. 

Brazil’s capital is the largest 

metropolis in South America, and one of 

the most influential cities when it comes  

to arts and entertainment.

I’m here with my wife – who was my 

girlfriend at the time of the move – and we 

Will Murai
Perfectly formed The busy artist explains how every inch of  
his small but stylish São Paulo workspace is designed to inspire

thecreatorhd
http://ifxm.ag/psevy

They’re mutants, yeah. But they 
were mutants before it was cool. 
Now they’re totally ironic mutants. 
The first in a series of “hipster 
redesigns” of comic book 
characters by thecreatorhd, sees 
X-Men given a Williamsburg 
makeover – Wolverine in a beanie 
being a particular highlight.

Mag3llan
www.mag3llan.deviantart.com

“A little world project I’ve been 
thinking of lately,” writes Mag3llan 
in his description of this piece. 
“We’ll have to see if it’s something 
I’ll continue.” With a deft use of 
light and shadow, a cityscape full 
of detail, mystery and intrigue,  
it’s certainly something we’d like 
to see more of. 

kerbyrosanes
http://ifxm.ag/krosanes

This mesmerising work in progress 
by Kerby Rosanes is part of a 
commission to create cover art  
for a forthcoming album by New 
York’s Chuckie Campbell. With a 
nod to da Vinci’s Vitruvian Man, it’s 
a stunning, intricate piece of line 
work that demonstrates a good 
eye for detail. 

ImagineNation News
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The Cintiq, undoubtedly, is my main drawing board and canvas 
today. It’s hooked up to a 27in iMac with lots of RAM and some 
extra hard drives working as scratch disks.

I made this stretched canvas to celebrate the new identity of my 
portfolio. My great friend Rentz Munhoz (www.rentz.com.br) 
designed the logo, which has been used on all my products.

Every workspace should have ergonomic chairs.  
I’ve had this one for about five years and it still  
feels like new. They’re designed to comfortably 
accommodate the vertebral column. In addition,  
the mesh assures that your bottom doesn’t feel like 
mashed potatoes by the end of the day.

When I organised this 
space I made sure all 
my entertainment and 
visual stimulation was 
easy to find: my books, 
magazines, toys, 
comics, DVDs, music 
and games are all just a 
few centimetres away.



A few years later, I choose to work as a 

freelancer, which meant we had to adapt our 

living room into my studio. Even if a few 

extra square metres would be useful, the 

small space isn’t a major problem for me 

because most of my work is done digitally. 

I try to keep my workstation as clean as 

possible, with only the computer and Cintiq 

on it, and I use a trackpad instead of a 

mouse. Besides being a great device for 

multi-touch gestures – such as rotate, pinch 

to zoom and so on – it also frees up space 

on my desk.

When it comes to traditional stuff, I only 

keep my sketchbook and pencils around.  

I still prefer to use them to sketch initial ideas 

and concepts. 

In my typical working day, I try to deal 

with emails, accountancy, meetings and all 

other organisational activities during the 

day, then I begin the artistic, creative stuff 

late at night. I put my headphones on and 

work until I get sleepy, usually at around  

3am or 4am. I find it very productive to  

be able to work non-stop this way, without 

any distractions. 

Brazilian illustrator and concept artist Will 
Murai counts Applibot, Marvel Comics and 
Wizards of the Coast among his clients. You 
can see his art at www.willmurai.com. 

This is issue 86 of ImagineFX – I created the cover. It sits 
alongside various other books. One of the best things about 
working from home is that I can enjoy these things anytime. 

Artist news, software & events
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Our place is located in one of the busiest areas of central 
São Paulo, just a few blocks from Paulista Avenue. But it’s 
surprisingly quiet, even during the day.

My wife and I are fanatical collectors of anime figures and toy art.  
You can find limited edition statues, action figures, vintage toys and 
Evangelion-related stuff on my shelves. 

Although my work is digital, sketchbooks are 
always around, so I can quickly visualise an idea.

This is a custom, hand-painted Mini-Me I created as a joke. I like to fill my 
workspace with pieces that stimulate creativity, however silly they may be. 



WIN PRIZES!
Congratulations Sezar – you’ve won two ImagineFX specials of your 
choice! To get your hands on similar prizes, see our Forum challenges 
at www.imaginefx.com/forums

MYFX TITLE: Cute but Deadly 
WINNER: Sezar Salzer (SZR) 
GALLERY: http://ifxm.ag/salzer0 
ALL ENTRIES: http://ifxm.ag/cutedeadly

Sezar Salzer is a self-taught painter with a keen eye  

for charismatic character designs. “My main 

inspirations,” Sezar says, “are the gorgeous work  

of Disney and Pixar artists. I try to create similar 

characters, in the same style.”

Munich-based Sezar, who works anonymously using a 

pseudonym and avatar, created Cute but Deadly using Photoshop. 

He began without line work, instead blocking in monochrome before 

switching to colour with a separate layer for blending styles. The 

result is a green and furry, but dead-eyed and vicious, creature that’s 

slain a monster more than twice its size. “It was a challenge,” Sezar 

says, “to keep the creature sweet and deadly at the same time.” But 

then, by definition, challenges aren’t meant to be easy.

Sezar blocked in 
monochrome, then 
switched to colour with 
a separate layer for 
blending styles. He 
didn’t do any line work. 

Winners
Forum 

Ahhhh… aargh! In the real world, petting a cute-
looking critter is usually pretty safe. But in a fantasy 
environment, don’t even think about it!

Image of the month

IMAGINEFX CRIT
“I love the story in Sezar’s piece  
and how the highlights bring out 
busy textures in the foreground.”  

Daniel Johnson (Squaredmotion)

In the world of fantasy beasts, nothing is 
what it seems. Clearly, Sezar’s furry creation 
doesn’t like to be tickled behind its ears!
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“I enjoyed painting  
the Dream Keeper 
character,” says Bon.  
“It feels like I’m creating 
a precious dream while 
at the same time 
capturing and 
depicting it through  
the painting.”

MYFX TITLE: The Dream Catcher  
WINNER: Bon Jovi Bernardo (Bon) 
GALLERY: http://ifxm.ag/bernardobonjovi
ALL ENTRIES: http://ifxm.ag/catcherdream

“This was my first time entering an ImagineFX art 
challenge, and I’m grateful to those who voted for my work 
to be the winner. The captured dreams turn into images 
that will later be bound into a book by the Dream Keeper. 
The bowl of water or mirror-like object is a special element 

called a Dream Finder. With the help of my Dream Keeper, I hope all of 
my dreams will come true.”

Forum winners
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MYFX TITLE: It Came from the Deep 
WINNER: Jon Abbiss (Zinc) 
GALLERY: http://ifxm.ag/jonabbiss
ALL ENTRIES: http://ifxm.ag/fromthedeep

“It was good fun creating a trashy, 
straight-to-video movie poster 
– complete with beasty, bikinis 
and a cheesy tagline. If I’m being 
honest, I probably bit off more 

than I could chew, considering the time limit. 
However, it enabled me to experiment with 
more of the options in ArtRage – a cheaper 
alternative to Corel Painter, with tools that 
replicate watercolours and oils.”

Join in! 

www.imaginefx.com/forums

Jon says he found it tough painting under the 
challenge’s time constraints, but nevertheless 
his final image was a winning effort.



A major MS5 
fan writes
Greetings Claire! I just read issue 
102, my first issue as a subscriber 
after plucking this magazine from 
the local bookstore shelves on and 
off for the past year. 

It was nice to see a page on Manga 
Studio 5 EX, and at the very 
beginning of the article it mentioned 
a previous review of Manga Studio 5 
earlier in the year. I was wondering 
what issue that was in, as I fear I may 
have missed it?

Also, as a major fan of the 
program, I’m hoping to see more 
examples of professional-level art 
from Manga Studio users in future 
issues. Obviously Manga Studio is 
excellent for graphic storytelling, but 
I’m also keenly interested to see how 
non-comic artists are putting the 
program through its paces. 

This image [below] is my most 
advanced painting experiment with 
Manga Studio 5 to date. I’d like to see 
what other artists, of greater calibre 
than myself, can do with this 
software. And I’d especially like to 
see how they do it. Thanks very 
much for reading this!

Sincerely, from a devoted reader.
Kyna Hansen, via email

Claire replies Hello. We reviewed 
Manga Studio 5 in issue 93, Kyna. 
Hopefully you enjoyed the great 
Manga Studio 5 workshop from Dave 
Kendall in issue 104. If you haven’t 
spotted it yet, it’s worth checking out.

Go digital!
I purchased a Retina display iPad 
and tried out an enhanced digital 
issue. I had been hesitant, because 
I love the tactile feel of the 
magazine. But the advantages of 
the digital version far outweigh 
those thoughts. Wow! Being able 
to zoom in on the artwork and 
text is fantastic. Instantly playing 
tutorials with the tap of a finger is 
just great. I love the printed page, 
but when something comes along 
that makes the experience exponentially 
better, it’s hard to ignore.

For anyone out there who’s sceptical 
about the digital version of ImagineFX,  
give it a try – you won’t want to go back!
Gary Baker, via email

Claire replies Thanks Gary. For readers 
who haven’t tried our digital editions, it’s 
worth knowing that we provide all of the 
resources that come with the magazine. You 
can sign up for a free trial with the various 
service providers, and you can find these 
details on the opposite page, and also on 
page 83. Fear not, print readers, we are also 
available as a physical page-turning edition!

No digital!
I’ve had a print subscription for years and 
now I want to go digital. But your website 
says you don’t support Microsoft devices.  
I don’t understand that, as Microsoft’s 
Surface is a great tool with a pressure-
sensitive pen. As my space is limited I can 
no longer subscribe to the print version. 
Please let me know if you plan to support 
this device in the near future.
Walter Herndlhofer, via email

Claire replies Walter, we do support 
Microsoft Surface Pro (there are so many 
tablets, and so many ways to get hold of 
digital editions it bamboozles us at the best 
of times, too!). You can use either Zinio or 
nook to access ImagineFX digitally. See the 
page opposite for more details.

DID YOU MISS 
ISSUE 104?  
See page 63 for 
details on how to 
get hold of a copy.

CD wallet please!
At first I wasn’t happy about losing “my” 
disc, but now I agree with all those who 
prefer the download versions of your files. 
However, I prefer to keep a disc with all the 
files per issue. I store the disc in a plastic 
sleeve, so here’s my question:  
is it possible to make a 
printable sleeve each issue? 

It will keep my 
collection of discs up-to-
date and when I can’t move 
anymore I’ll take them all into 
my grave, because I’m sure they do not have 
your fabulous magazine up in Heaven!

You already received so many 
compliments and they are all right. Really, 
ImagineFX saves my artistic life. I hope 
ImagineFX will stay for many, many years 
because I can’t live without it.
Rudy Tent, via email

Claire replies Hello Rudy. Well, it’s an 
interesting request! I’m not sure how many 
other readers want this, though. So, readers, 
is this something you want us to do? 

Hard to read text
I’m an ImagineFX subscriber. The range of 
topics, techniques and artists represented  
is truly brilliant and the quality of the 
magazine is beyond reproach.

Here is my dilemma Claire: I’m middle-
aged! And if this isn’t bad enough, my old 
peepers are not what they once were. So can 
you and the staff re-evaluate the use of the 
small, thin, Helvetica-esque font you use for 
body copy? An example would be the image 
on page 49 of issue 103, Dance With the 
Wind by Vian Lee [see below]. The text 
bubble copy is almost impossible to read, 
even on the dark background colour.

I won’t speculate about the demographic 
target of your readership, but as a middle-
aged guy, I can safely say the type is too thin 
and small to read in the text bubbles.
Tony Stencel, via email

Claire replies Tony, sorry to hear that you 
are having trouble reading some of the text. 
Rest assured, you’re not alone: being 
middle-aged is a dilemma we all have to 
face! Joking aside, I haven’t heard of others 
finding that font hard to read. But we’ll keep 
an eye out for readability in the future.

“Wow!” says Gary Baker 
after trying our iPad 
edition. He urges 
everyone to “give it a try”.

Kyna used MS5 to create this art – she wants to 
see what others have used the software for.

ImagineNation
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Our star letter writer wins a  
dA Premium Membership!
 Browse more content more quickly  
 Customise your profile page Receive 

exclusive discounts & offers  And more!

Contact the editor, Claire Howlett, 
on claire@imaginefx.com or write 
to ImagineFX, Future Publishing, 
30 Monmouth Street, Bath,  
BA1 2BW, UK
Follow us on twitter: 
www.twitter.com/imaginefx
Tell us your thoughts on: 
www.facebook.com/imaginefx

YOUR FEEDBACK & OPINIONS

Tony Stencel says he has trouble reading Sketchbook. 
Does anyone else have the same problem with our fonts?



Learn to create amazing comic art in Photoshop, Manga Studio, SketchUp 
and more, using 12 all-new tutorials from the world’s leading artists!

ON SALE NOW! Order your copy today at www.zinio.com/imaginefxspecials



Apple Newsstand: www.bit.ly/ifx-app

Android, PC & Mac: www.zinio.com/imaginefx

Barnes & Noble NOOK: www.bit.ly/ifxnook 

Google Play: www.bit.ly/maggoogle

Get our digital edition!
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SEEING THE BIGGER PICTURE

Try not to get ahead of yourself. It’s 
best to 

work on the entire image at once and not 

focus on a single area. Start out with the 

broader strokes and build up the details on the 

whole image slowly.

Artist’s secret

GOT A QUESTION FOR OUR EXPERTS? LET US
EASE YOUR ART-ACHE AT HELP@IMAGINEFX.COM

Answer
Jace replies

Feather boas are an excellent 
accessory to complement a 
pin-up girl. There’s just 
something very sexy about 

feather boas and getting that playfulness 
and sexiness right can really help make a 
piece stand out from the crowd. However, 
the focus shouldn’t be just on the boa,  
but also on the pose of the pin-up and  
how the boa is being used to tell that 
character’s story. 

Playful gestures with the figure 
twirling and twisting the boa around 
the neck can do a lot to really sell the 
sexiness of the piece. As usual, collecting 
reference is a key point in starting any 
illustration. Getting the reference to match 
the final illustration as close as possible 
will go a long way in helping the final piece 
look great. Yes, you can go online and 
search around for suitable photographs, but 
you’ll achieve the perfect pose if you 
purchase a cheap boa and take a few snaps 
of yourself in front of a mirror.

The brushes I use to paint the feathers in 
this piece are long oval brushes angled at a 
45-degree angle to create feather-like 
shapes. The brushes are set with a Flow of 
22 per cent, Opacity at 100 per cent, 
Opacity set to Pen Pressure and Size set  
to Pen Pressure.

Question
I want to paint a feather boa. Any tips  
would be greatly appreciated
Karen Lindsey, England
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Waldemar Kazak
Waldemar left art college in 
1993 to work as a designer. 
Inspired by a love of illustration 
from the 60s and 70s, he’s 
now a full-time freelancer.

www.waldemarkazak.com

Goñi Montes
After receiving a BA from the 
UPR at Mayagüez, Goñi 
worked as a scientific illustrator 
for the Puerto Rico Sea Grant. 
Today he paints fantasy art.

www.goniart.com

Matt Dixon
Matt first created artwork for 
a video game back in 1988, 
and has since worked for 
Blizzard. His pin-up art can be 
seen in his book Girls On Top.

mattdixon.co.uk

Serge Birault
Serge has worked for the 
music industry, video games, 
publishing and advertising. His 
art book, Corpus Delicti, is 
available now.

www.sergebirault.fr

Nadia Enis
Nadia lives in Berlin and works 
as a freelance artist for the 
games industry. In her free 
time she daydreams about 
drawing her own comic.

www.minosch.deviantart.com

Jace Wallace
Jace has freelanced for 
magazines, book publishers 
and produced concept art. 
He’s since been hired by Maxis 
to do concept art for Sims 3.

www.wakkawa.cghub.com

Tony Foti
Tony is a US freelance 
illustrator who contributes 
to D&D and Fantasy Flight 
Games’ Star Wars and The 
Lord of the Rings lines.

www.tonyfotiart.com

DOWNLOAD RESOURCES http://ifxm.ag/oolala105
VIDEOS • FINAL ART • WIPS



2

1

3

Step-by-step:
How to illustrate 
feathers accurately

Question
Can you give me some ideas for painting classic 
pin-up hair styles from the 1970s? 
Tafari Christianson, Ethiopia

Answer
Tony replies

To get a feel for specific hair styles,  
I suggest looking at photos from the 
time period for a while. Not just 
television and movies, but candid 

photographs of everyday people. Certain styles 
can be attributed to certain personality types. For 
example, if you saw a man from the 70s with hair 
down his feet and a long beard, chances are he’s 
not a drill sergeant. Likewise, you wouldn’t want 
to depict someone who’s been living on the 
streets for two years as having a perfectly cut, 
blow-dried bob that could only be created with a 
lot of care and attention.

As a general rule, every part of your characters 
should be telling an aspect of their story. You 
could use messy hair to imply that the character 
hasn’t showered that day, or incredibly difficult-
to-style hair to show that a person spends too 
much time on their image. For this pin-up I’m 
painting, I want to give the impression that  

she’s fun without diverting too much attention 
from her face. 

Similar to painting leather (see my other Q&A 
article on page 36), one way to break down hair is 
to think in three layers. Start by painting in a mid-
tone, focusing on having an outline that reads 
well. Using the silhouette as a base, you can then 
paint in shadow and highlights to create depth.

Choosing the right 
hairstyle for your 
characters is as 
important as clothing 
choice. How people cut 
and comb their hair can 
say a lot about a 
person, so choosing the 
right shape is simply a 
matter of personality.

A nice, round shape like 
this bob moves the eye 
without making a 
spectacle. The more 
novel the hairstyle, the 
more it’ll stand out as a 
focal point.

 To depict an interesting feather boa,  
I need to work on its silhouette. I use 

the Free Lasso tool to create an interesting 
shape to work the details in later. After the 
silhouette is created I use my oval Soft 
brushes to create a noise layer of values 
that I’ll use to make the feathers. Feather 
boas are a sort of controlled chaos.

 It’s time to refine my feather boa. I start 
by building feather forms out of the 

random value shapes that I created earlier. 
The brush has the same settings as before, 
only smaller. This means the edges will be 
more refined. After some of the forms are 
brought out I add cast shadows from each 
feather, which gives them a sense of depth.

 I want to bring the feathers’ shape out 
some more by using highlights and 

even smaller brushes. Bright highlights 
around the edges of the feathers make 
them look crisper. So while the feathers in 
the light are sharper, the feathers in the 
shaded parts tend to be a little less defined, 
which brings depth to the composition.

SOFT EDGES, SOFT HAIR
The harder your edges are when painting hair, 

the more rigid it will appear. Long, flowing locks 

often feel most natural when they’re not too 

rendered. Blur implies motion, so soften your 

edges whenever an area feels too stiff.

Artist’s secret
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Answer
Tony replies

Some leathers are heavily 
sanded down during the 
manufacturing process to 
remove imperfections, and 

others keep the original grain. This is one 
of the most important things to consider 
before painting, because how reflective an 
object is has a profound effect on the light 
and shadows that move across it. 

Some leathers are so dull (in terms of 
surface texture) that light falls on them the 
same way it would across cotton. Others, 
like patent leather, are more stiff and shiny. 
The more glossy the finish, the less light 

Answer
Jace replies

Warm, soft lighting can be 
created in a lot of different 
ways. Sharp lighting as created 
by the sun during the midday 

hours reflects in the skin a bit differently 
than softer lighting created at different 
times of day or by other sources of light.

In this example I chose my light source 
to be an artificial light, such as a light bulb. 
This type of lighting will not only be warm 
but, since it’s also diffused, there won’t be 
many sharp shadows being cast on the face, 

will follow the form principle (where 
light appears on any surface that has no 
obstruction between it and the source). 
Instead, light will appear as distorted 
reflections of its source and be generally 
less prevalent.

Not surprisingly, painting leather is quite 
similar to painting skin. Feel free to start 
however you like, but I generally put the 
mid-tone down first, then paint on the 
deepest shadows, and lastly add in the light. 
Not only does this keep the painting 
process straightforward, but I think the 
result also tends to look nicer.  

which creates a nice, soft mood. Another 
important compositional aspect to keep 
in mind when creating a scene like this is 
colour contrast and balance. To focus on 
the warm lighting there needs to also be 
cooler shades present to really push the 
warm overall atmosphere. 

The girl’s face in our example will be the 
warm section and her hair will contrast that 
with a nice cool colour scheme. This 
example was created using Photoshop using 
both hard and soft Round brushes.

Question
What’s the proper way of  
creating a leather-clad lady?
Chris Egan, Cayman Islands

Question
Can you help me draw classic 
cheesecake facial expressions?
Alf Jones, US

Answer
Matt replies

In my view, the facial expression is the defining 
element of true pin-up artwork. Pose, costume and 
setting all play their part, of course, but for me  
pin-up is all about attitude. Choosing an expression 

that correctly communicates that attitude is essential. The key 
elements here are confidence, humour and enjoyment.

Confidence is best demonstrated through direct eye contact 
with the viewer. This shows that your pin-up is unashamed of 
whatever situation you have chosen to place them in, and helps 
to welcome your audience into that situation.

Humour doesn’t necessarily mean that your image has to be 
funny or contain a gag, but whatever you choose to paint, your 
pin-up should have good humour. They should react to their 
situation in a positive manner, with perhaps a wink or a cocked 
eyebrow, or open-mouthed surprise at something in the scene.

Enjoyment is perhaps the most important aspect of your 
character’s expression. This communicates that your pin-up is a 
willing participant in the scene and is in control of the situation. 
If your pin-up is enjoying what you’ve painted it’ll help your 
audience to do so, too! A smile or laugh is obviously the best 
way to get this across.

Question
I’d like some ideas on playing with lighting 
on my model’s face please
Sylvie Seymour, Gibraltar 

This example is the 
same figure, but under 
an artificial light such as 
a light bulb, candle or 
fire. The shadows are 
diffused and the overall 
tone is warm, creating a 
very sensual mood.

A three-quarter 
profile and a slight 
downward dip of 
the head is a classic 
pose. Note that the 
smile is not just on 
the lips but also the 
cheeks and eyes.

Even with more 
contemporary 
styling, the right 
facial expression 
ensures that this 
character has a 
classic pin-up feel.

Here our model 
is under the hard 
midday sun. This 
lighting has a 
strong visual 
impact with its 
cast shadows and 
bright highlights, 
but no mood…
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Question
How do you depict perfect skin  
for a perfect pin-up?
WolfKnife, Italy

Step-by-step: Illuminating leathers

 The first thing I do is put down the 
midtone. Use this opportunity to 

paint in the main shape as accurately as 
you can. Silhouettes are an important tool 
in communicating form, and this is great 
chance to get it right before complicating 
things with light and shadow. 

 For a glossy look, strong light should 
show where reflections would go. On 

leather this is often the crest of each fold. 
Be sure to paint the surface textures that 
are revealed in the light, particularly in the 
transition from light to halftone. This keeps 
the material from feeling too smooth.

 Study reference to get a feel for the 
type of leather you’re painting. Soft, 

turning folds need smooth edges, while 
sharp kinks can be handled with hard, bold 
strokes. When a surface folds, the creases 
that form will be getting less light. The 
deeper the crease, the darker the shadow. 

Answer
Goñi replies

Getting smooth, flattering 
skin isn’t hard at all using 
Curves in Photoshop. Begin 
with a simple palette: light 

peach for your base colour, neutral blue 
for your shadow, and black, which will 
be used to intensify blue shadows. After 
setting up a light source, make sure the 
shadows hug the figure so as to describe 
its contours. Always keep the shadows 
soft by using a combination of feathered 
brushes, gradients, and the Blur and 
Smudge tools. Avoid too much contrast 
– it will make facial features too harsh, 
angular and inappropriate for a pin-up. 

Remember to cast a rim light on the 
side opposite the light source. After you 
paint in your blue shadows, make a 
selection of them and create a new layer. 
In this layer, add a black gradient, 30-50 
per cent Opacity, from the direction of 
your light source. This helps model the 
features by slightly intensifying the 
shadows where they come into contact 
with the light. Add a low-opacity white 
gradient right where the light source hits 
the face. At the top of the stack add a 
Curves adjustment layer. Select blue 
from the menu in the dialog and raise 
the curve on the darker tones, while 
lowering it in the light tones. Then select 
red and do the opposite: high on light 
tones, low in dark tones. This is a good 
trick to give the skin warmth and depth.

Believe it or not, I’ve used 
only three colours to 
attain this much variety 
in the skin tones.
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Artist’s secret
CREATING COMPLEX 
COLOURS WITH CURVES

Curves enable you to 

accomplish a lot of 

complex colours 

after originally 

using very few. 

Experiment with 

the graph ’s line 

– you’ll be surprised!
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Question
Can you help me paint an alternative pin-up?
Shadow Nasty, US

Step-by-step: Depict a pin-up figure with attitude

photo studio’s, not natural outdoor light. 
Even if the girl strikes a pose in bright 
sunlight, she should have strong reflections 
coming from the sand, water and parasol. 
Make the whole picture brighter and shinier 
than your normal character piece.

Many artists use Photoshop, but I prefer 
Corel Painter. It may not like layers but 
then neither do I! I use several specific 
brushes which are based on real brush 
imprints. Before painting digitally I spent 
time using gouache, and I still have some 
of the brushes I used around my house. So 
I scan their strokes and use them in most 
of my drawings. I like their rough texture. 
And it will fit alternative pin-up better than 
airbrush, I think.

Answer
Waldemar replies

Whether I’m painting classic 
cheesecake or a snarling 
alternative pin-up, I spend 
some time with pencil and 

paper. Digital offers too many options too 
quickly. Paper prevents your hand from 
getting ahead of your imagination, and 
enables you to develop ideas and shapes 
at a comfortable pace.

Classic pin-up was all about smiling and 
fun, and of course being incredibly sexy. 
Things may have changed as far as what 
people consider attractive, but some things 
are still relevant: the factitious pose, the 
somewhat silly jolliness and an expression 
of surprise. More importantly for me,  
the character’s lighting should be like a 

 In my pencil sketch I try 
to define character and 

composition. I want her face in 
the centre. I consider the path 
that the viewer’s eye takes, and 
position her face on one of the 
diagonals. This guides the 
viewer through the curve of 
her body, then along her right 
hand to the can, and through 
her left hand back to her face. 
It’s hard to see it yet – tone and 
colours will help me with that.

 Pin-up is usually all about 
tanned hips, blue sky and 

colourful clothes, but this won’t 
suit a punk character, so I pick 
a cooler, darker palette. I fill the 
background with a purple-grey 
neutral tone, making it easier to 
define bright and dark colours. 
The brightest will be her hair, 
the most saturated the candy 
box. To emphasise her curves  
I add a red splash on the wall, 
and a pink one to balance that.

 I fix major elements and 
assign colours to them 

so they’re in harmony. For 
example, it’s useful to use 
visual ‘rhymes’, such as the 
obvious big pink shirt and small 
pink lips, and not-so-obvious 
green eyes and red candy box. 
Now it’s time to work on 
volume and texture, add a 
second light source – another 
pin-up trick: hard backlight. I 
also smooth the girl’s features.

 I hide the original outline 
drawing by changing its 

blending mode from Multiply to 
Overlay. This way I still can find 
and conceal it again as I work. 
It may sound inconvenient, but 
I merge all my layers, making 
the digital process closer to a 
traditional one. Finally, I work 
on details such as the eyes, 
mouth and rivets. I then use 
Photoshop for final texturing 
and colour correction.

Mixing pin-up with 
punk means balancing 
disparate elements, 
such as the girl’s light 
shirt, lips and hair, with 
a grungy textured 
background.

PRETTY IN PINK
Your alternative pin-up can be tough and 

listen to metal, but she doesn’t have to be 

too dark. I’ve hinted at her gentler side 

with the pink shirt. The wall ’s texture in 

the background is still rough, mind!

Artist’s secret
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Answer
Goñi replies

Although not as reflective 
as some of the shinier 
metals, rubber and latex 
must be treated almost 

equally. For this I use some of 
Photoshop’s simplier brush options: 
specifically, Opacity Jitter under 
Other Dynamics in the Brush Panel.

Rubber and latex are highly 
specular surfaces, and so are very 
high contrast. This means the light 
source will be reflected back crisply 
instead of being diffused across the 
surface. The entire value range is also 
encompassed in a very small area, so 
highlights can abruptly come into 
contact with shadows.

Start by defining your light source 
and casting some shadows. These can 
be left quite sharp. Your highlights 
will be even more stark and barely 
need diffusing. Of course, make sure 
that these highlights and shadows 

Question
Can you give me some tips on 
painting shiny latex/rubber please? 
Jenny Mendzka, Poland

Question
How can I push the anatomy of a  
pin-up to make her more interesting? 
Spud Henning, Sweden

hug the figure so they clearly define 
the body’s curves. Trial and error 
may be necessary.

Your rim lights are extremely 
important. Highly specular surfaces 
are very sensitive to light. The 
original light source will likely 
be reflected from neighbouring 
surfaces. Latex and leather will pick 
up these mild reflections. 

Question
How would you avoid clichés  
in pin-up? 
Rich Spifftown, Germany

Answer
Nadia replies

It’s a matter of taste, but 
a good illustrator tweaks 
anatomy, perspective 
and pose so the lines are 

most appealing. This also applies to 
shapes and negative space. You can 
also concentrate on the lines of 
gesture: in a pin-up the gesture can 
include bodyweight, gender specific 
physics and storytelling of the 
motif, just to give you an idea.

Another guideline is the Golden 
Ratio, which you can also find in 
human proportions. You can push 
your anatomy in this direction. For 
example, I combine the parts of her 
hip and thighs into one line. That 
gives me a pretty line, but it also 
enables me to shift the focus from 
the crotch up to her waist. And her 
waist is in the Golden Ratio. Think 
in terms of lines, shape and Golden 
Ratio first, then put in the anatomy 
required for your style or taste. 

Answer
Serge replies

There are so many ways 
to do something 
different, something 
unique. Just think about 

this: to do pin-up art you just have 
to paint a sexy girl or boy, and the 
rest is up to you. There are so many 
things you could try, such as a new 
composition, mood, style, 
rendering or colours. 

Naturally, pin-up has its own 
code and there are a lot of clichés. 
But sometimes it can be fun to work 
with stereotypes. Take a very bad 
girl, a super villain, and paint a cute 
picture with her, for example. 
Instead of using clean and cartoon 
lines, try something different – try 
to achieve a painterly look using 
textured brushes and classical 
painting palette. Finally, don’t forget 
that your picture doesn’t only have 
to be a sexy picture. You can also 
add a mix of feelings and moods.

The colour of your light source will be 
reflected in your main highlights, but your 
rim lights will be affected by nearby surfaces 
casting reflections on your latex or rubber.

The composition is very simple, but it adds 
a quiet mood to the scene. I chose very 
soft tones for the same reason.

When you focus 
on lines and 
proportions you’re 
free to push the 
anatomy any  
way you want.

Keep an eye on 
general art rules, 
such as the 
Golden Ratio and 
balance of weight.

Rubber and latex 
are highly specular 

surfaces, and so 
they are very  

high contrast.
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Use Photoshop’s layer options to adjust the 
aged-look of the digital canvas.

Instead of using aged 
paper as the background 

texture you could try 
cardboard or old canvas.

Question
What do I need to bear in mind  
when drawing a male pin-up? 
Jess Acer, US

Question
Can you help me give a  
pin-up piece a vintage feel? 
Carlos the Jackal, Venezuela

The hands, defined underarm muscles, 
wide shoulders, strong eyebrows and the 
space between jaw and ear are some parts 
you can rely on to catch the viewer’s eye. 

When you come to the details, such as 
nose and fingernails, it’s good to stick to 
straight lines, especially if you don’t have a 
clear vision. Doing this will keep the look 
fresh, masculine, elegant and tight. Don’t 
obscure key body elements with sloppy 
brush strokes – these details will dictate the 
quality of your art. Furthermore, if not 
expressly called for, try not to make your 
figure too muscular or hard looking. A sense 
of the erotic comes with the surface softness 
that obscures the strength underneath.

Answer
Nadia replies

First I want to point out the 
difference between a superhero 
and a male pin-up. The 
superhero was primarily 

designed to appeal to young boys, and 
symbolises power and masculinity. The 
purpose of a male pin-up is completely 
different, so don’t confuse the two and their 
specific visual language. 

When tackling a male pin-up I would 
advise following the same rules for 
depicting a female pin-up. Think about  
your storytelling elements, the layout and 
colour choices. In addition, you have to 
identify specific body areas that admirers of 
the male pin-up genre will find attractive. 

Attractive male parts are, for 
example, the hands, triangle 

shape, underarms and chin area. 
Exposing those is half the deal.

Answer
Waldemar replies

I’m approaching this question having created the 
majority of the painting, so this is more about the 
texture that I’m going to apply. Sometimes an 
‘aged’ painting is in the detail that you may not 

even notice straightaway. I’m not talking about taking a cup of 
tea or cigarette lighter to the edges of a white piece of paper!

I scan in some naturally aged paper from a book, then 
clone it to the size of my image. In pre-digital days, pin-up 
paintings were oil on canvas that were then photographed 
and retouched in the printing colour correction process. I’m 
going to emulate this process in Photoshop. 

I apply the texture of paper, then pretend I’ve 
photographed it by boosting the contrast a bit, making the 
edges slightly blurred. Then, after taking away some detail,  
I add clarity in shades. First I duplicate the picture layer, and 
then use Photoshop’s Curves or Selective Color to give the 
shadows and dark areas a cool tone, and the light areas and 
mid-tones a warm tone. Then I lower the contrast of the 
entire layer, change the layer blend mode to Soft Light and 
reduce its Opacity. Next I create another layer and import 
the texture of the old paper. I set the layer to either Multiply 
Blend mode or Overlay and drop the contrast. After these 
digital manipulations I introduce a hint of warm sunlight 
throughout the image. 

Artist’s secret
A CLEAR CUT
A good way to keep your figure handsome is to use only straight lines for the construction. After that you can start softening the lines. Put extra effort into key body elements such as 

hands, or else your picture will lose impact.
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3

Got a digital art problem? Is an image giving you art-ache? Our panel can help. Email your question to our 
experts at help@imaginefx.com or write to Artist Q&A, ImagineFX, 30 Monmouth St, Bath, BA1 2BW, UK.

 Now I can start to have some fun and 
work in some more extreme elements 

to really establish that our pin-up is a 
zombie. I simply add a few small areas 
where the skin has been damaged and 

broken. I like the idea 
that these flesh 
eaters might be 
trying to chomp on 
each other, so I 
deliberately shape 
some to look like  
bite marks.

Question
How should I approach  
painting a zombie pin-up? 
Robert Palmer, France

Answer
Matt replies

I firmly believe that pin-up is all 
about attitude. If your pin-up 
displays the right personality 
then I don’t see any reason why 

a zombie, or any other horrific or 
monstrous character, shouldn’t be an 
effective pin-up. 

However, I think it’s fair to state that a 
well-rotted zombie with missing limbs, 
exposed bone and a bloated stomach, 
trailing pale green juice behind it, is going 
to be very difficult to present as a pin-up in 
the traditional sense! I would suggest that 
the best approach would be to design an 
image with a strong pin-up flavour first, 
and then look to add zombie elements in a 
way that supports or enhances the character 
and image overall, without causing outright 
revulsion in your audience.

Consider iconic cues that would mark a 
character as a zombie: discoloured skin, 
rotten flesh, matted hair, claw-like 
fingernails, glazed eyes and so on. Then 
think about how they might relate to  
pin-up artwork to find subtle ways to 
introduce them into your artwork. Glazed, 
sunken eyes and discoloured lips could 
approximate makeup. A unkempt hairstyle 
is a popular look, and is not so far from 
looking matted. Long nails are a pin-up 
standard. Rather than show graphically 
rotting flesh, simply colour the skin to 
indicate some decomposition.

Bringing all these elements together  to 
create a kind of ‘undead glamour’ look for 
your character should be very effective and 
presents a great opportunity to have some 
real fun in your image!

Artist’s secret

Step-by-step: Give your undead some oo-la-la

 Don’t worry about the undead 
elements to begin with. Sketch out 

your character and concentrate on the pin-
up pose, costume and attitude. If the sketch 
is firmly in pin-up territory you can begin to 

layer on the undead 
cues with confidence. 
Even zombies can be 
playful, so I’ve 
chosen to show my 
undead girls having 
fun and smiling at  
the viewer.

1 2

BUILD ON STRONG 
FOUNDATIONS
The same approach can be 
used to add unusual 
elements to any pin-up. 
Establish a strong pin-up 
pose in your sketch and 
that flavour will come 
through – even if you layer 
on some bizarre extras!

I use a putrid purple tone almost like makeup, 
drawing attention to the eyes and lips and adding 
some subtle bloom to the cheeks and nose. 

 Next focus on colour. Realistic-looking 
dead flesh may be unsettling, so 

consider more saturated tones instead. 
Cheerful colours will help to temper the  
horrific elements of your image and keep 

the painting light 
and fun. Dead flesh 
often turns blue,  
and green is 
associated with 
decay, so they seem 
like obvious colour 
choices to me. 
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PROFILE

INK TEST
“I treated myself to a brush pen and some markers 
recently after being inspired by Alvin Lee’s posts on 
Instagram and Whilce Portacio’s on YouTube. This 

was a test for inking techniques  
and comic styling.”

Alex Stead
COUNTRY: England

Alex is a freelance 
storyboard and concept 
artist from London. He 
sees his role as visualising 
event spaces and the 

narratives that take place within them. 
He spends all his spare time writing 
and producing artwork for his first 
graphic novel, a sci-fi epic. 
www.alexsteadart.com

Alex opens up his sketch
book to share p

assions ranging 

from 1950s female fashion to 
unstoppable kil

ler cyborgs…

NOVEL APPROACH 
“A study for my graphic novel. I love drawing  

the characters for my novel because each of them represents 
an artistic love of mine – whether it be Americana, 1940s  

and 50s fashion, Art Nouveau, steampunk,  
sci-fi… you name it.” 

LEG  
WARMERS 

“The things I enjoyed 
drawing most in this 
sketch were her legs. 

It was remarkably 
liberating to suggest 

their form by just 
crudely sketching  

the topology of the 
bed covers.”

I’LL  
BE BACK 

“All my figurines have a 
dual purpose: they enable 
me to embrace my inner 

geek and serve as 
invaluable references.  

My terminator statue is a 
great reference tool for 
clothing folds, casual 

jackets and biker boots, 
and to light figures 

dramatically.”
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DEDICATED  
FOLLOWER OF FASHION 
“My school teacher fashionista.  
My wife is always bringing back 
fashion magazines for me – she 

knows I love the reference. 
Inspired by some of my cuttings 

I’m starting to develop this 
‘paragon of virtue’  

for my novel.”

OLD SCHOOL 
“Vintage dresses exploration for 

schoolgirl character in my novel. A 
friend of mine has his own picture-

framing business and gave me some 
throwaway mountboard, saying it was 
great to draw on. It is. And remarkably 

cheap, too, if you know the  
right people.”

“My wife is always 
bringing back fashion 
magazines for me…”
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MY INSPIRATIONS 
“I love Modesty Blaise, especially the 
ink work of Eric Badia Romero and 

John Burns. Inspired by them, I drew 
much of this page trying to replicate 

the bolder tonal areas of a classic 
comic strip.”

WINGING IT 
“Would you ever get a 
group of paratroopers 

casually strolling along the 
full length of an aeroplane 

wing?  No. But it looks 
good. (Probably a 

subconscious tip-of-the-
hat to Commando  

comics’ Ian  
Kennedy, too.)”

MY TRUMP  
CARD  

“One of my entries to  
the Sketch Theatre 

competition. I don’t enter 
any now, though. Most of 
my time is spent working 
on my graphic novel, but 
every entry pushed me 
way beyond my normal 
sketching parameters.  
This one was A2 and  
was about 10 hours  

of work.”JUST BECAUSE 
“I wanted to draw a stylised 
oaf and ended-up sticking a 
big, boring rock in his arms.  
I asked myself the question, 
‘Why would he be holding 

this?’ And then it came  
to me: Why Not?”

FOR THE LOVE OF VINTAGE 
“My love of 1940s and 1950s women’s 
fashion is being tickled here. I love how 

markers give really subtle textures and how 
a brush pen can accentuate the  

vintage feel of a drawing.” 
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THEY DO THE MATHS 
“This is a study into the characterisation 

of another love: mathematics. The 
legends of mathematical history are so 
colourful – their drive, their genius and 
their desperation. I love the paradox of 

a logical mind and a thoroughly 
disorganised lifestyle.”

CHALLENGES WORK  
“My favourite Sketch Theatre submission. I won 

15 Gnomon DVDs with this entry for a Viking 
Berserker. I think more people should submit 

work for the monthly competitions.”

HASTA LA VISTA, BABY
“This is what happens when a drawing starts going wrong. 
My terminator was off balance and not looking very butch 

so I leant him against a wall, beefed-up his arsenal  
and surrounded him with destruction. When that  

didn’t work I gave him a cigar and said,  
‘To hell with it!’”

Want to share your sketches? Then drop us an email, with a selection of your artwork, to  
sketchbook@imaginefx.com, or upload your drawings at www.imaginefx.com/sketchbook.

RUNNING  
CHALLENGE

“I sketch with prescribed  
technical challenges to help my 
storyboarding. For this drawing,  

I set myself the task of sketching as 
many people as possible running 

in different poses with  
receding perspective. I like  

its energy.”

“I love the paradox  
of a logical mind  
and a thoroughly 
disorganised lifestyle”
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NO TELL MOTEL
“I love the rockabilly look, 
and gritty pulpy subject 
matter,” says Babs Tarr 
of her evocative 2011 
pin-up painting.
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Pin-up has grown up from its cheeky cheesecake days, with more artists 
expressing unique visions, brought together by a love of the human form

e get to decide 
what we want to 

do, and people get to 
decide if they like it or 

not.” So says pin-up artist 
Babs Tarr, and she could easily be speaking 
for a new wave of pin-up artists. Unlike 
previous ranks of women worshipers, they 

resist pigeonholing – a loose 
group of men and women 
around the world with 
different backgrounds, 
interests (other than women), 

all working in different mediums. In their 
hands, the genre has never been so exciting.

Golden age legends such as Gil Elvgren 
and Alberto Vargas are still admired for 
setting a pin-up standard in the 30s, but 
with more women artists specialising in a 

genre that’s exploded in themes and styles 
thanks to the digital revolution in art, the 
visual landscape – and the fuel that drives 
creation – has changed.

“Pin-up artists used to be mainly men 
drawing women for men. Those women 
were typically depicted with nothing more 
then a sweet smile and a couple of 
contextual props,” says Babs. “The current 
wave of pin-up artists are creating 
characters with more personality and 
power. That power is only enhanced 
when the piece is created by a 
woman… things have had to 
change, especially when you 
have an audience who now 
wants to be the pin-up, or 
at least find a narrative in 
the imagery.”

Things have had to change, 
especially when you have  
an audience who now  
wants to be the pin-up,  
or at least find a  
narrative in the  
imagery 

TEDDY DEAD
This 2010 painting by  
Aly Fell catches a pin-up  
with a lot on her mind!
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Aly Fell has been 
creating alluring, attractive 
and often quite dangerous 
characters for years, and puts 
his growing female fan base 
down to avoiding only passive muses  
or sexy sluts. 

“One of the phrases I hear often is that 
people see something else going on behind 
the eyes of my characters. And that’s what  
I want to do,” Aly says. “The women in my 
images are looking out at you saying, ‘This 
is my world and you’re a guest.’”

The women in 
my images are 
looking out at  
you saying, ‘This 
is my world and 
you’re a guest’ 

STRAWBERRY SWIRL
English artist Aly Fell often 

brings a darkness to his 
female characters, both in 

colour and personality. 

SCHOOLGIRL
For this piece 
Lorenzo Di Mauro 
mixed pencil, 
vector and 
Photoshop for a 
new take on an 
old-school theme. 
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P in-up art
THE GIRL NEXT DOOR
J Scott Campbell produces pin-up art for comic covers and 
calendars, and with motives as pure as his pin-ups 

He’s a Marvel comic cover 
artist and Adam Hughes’s 
favourite contemporary 
pin-up creator, but J Scott 
Campbell’s pin-up  
art is infused by the 

playfulness of his pin-up hero, Gil 
Elvgren. “I always aim for an 
approachable quality to my pin up, 
that adorable ‘girl-next-door’ look that 
so many of the 60s Playboy models 
had,” he says.

 “As I’m becoming older, I’m 
fascinated by subtleties,” explains  
J Scott. “It represents a level of 
sophistication I’m pursuing, and that 
really lends itself to drawing women.” 

Not surprisingly for a comic artist, this 
all has to do with character, with story. 
“The best pin-up artists are not only the 
ones who are more subtle, but who 
know how to build a story, who can hint 
to the reader that there’s a bit of depth 
to their woman,” says the illustrator. “It 
makes her all the more intriguing and 
attractive to the audience.” 

SIGNED: YOUR 
BIGGEST FAN
Maly Siri injects a bit of 
retro class into her pin-up 
art – a perfect marriage 
of pencil, ink, watercolour 
and gouache. 

RAPUNZEL
Setting the standard for 
beautiful pin-up comic 
covers, Adam Hughes 

recently created this image 
for the Fairest series.

For Adam Hughes, the Eisner award-
winning artist, his primary area of 

commissioned pin-up art is  
in comics, “where it’s resided 
for the past 20 to 30 years,” 
though even the mighty comic 
cover master admits that this 

has meant he’s been out of the loop when it 
comes to current trends in pin-up art.

COMIC CHARACTERS
What he couldn’t have missed is that 
comics are also home to plenty of male 
pin-ups. Mexican artist Melissa Ballesteros 
believes that, “A guy may look at a cover of 

Wolverine dressed in a tank 
top, flexing, claws out, and 
think, ‘Cool, what a badass.’ 
Whereas I might look at the 
same image and appreciate it 

on a more carnal level. Male pin-up art is 
out there – it’s just packaged differently.”

The notion of having a superpower is 
something many pin-up fans can 

appreciate. After all, from Olivia de 
Berardinis’s cheesecake perfection to 
Rebeca Puebla’s modern 3D visions from 
the dark side, this is fantasy we’re talking 
about. “Pin-ups have a totally magical 
quality to them. They’re a heightened 
version of us on our boldest, sexiest day,” 
says Babs. “If we choose, we can have this 
superpower of being a beautiful, 

intoxicating creature who draws people in, 
but also conveys an unapproachable 
ferocity along the lines of, ‘Don’t get too 
close or you’ll get a punch in the face.’ 
When I capture that in my drawing, I feel 
I’ve nailed it.”

True, Zoë Mozert, Pearl Frush and Joyce 
Ballantyne were among the best in classic 
pin-up. But where the Golden Age Three 
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FANTASTIC PIN-UP 
With colourist Nei Ruffino, J Scott is releasing 
another fantasy-themed pin-up calendar in 2014.



TENTACLE SLAP
German digital artist 
Daniela Uhlig takes 

themes and props from 
S&M and other pin-up 

artists’ work.

TATTOO GIRL 2012
Babs Tarr says, “I want 

tattoos but I’m too chicken  
to get anything permanent, 

so I drew a girl to cover them 
with. Each tattoo means 

something special to me.” 

were creating pin-up paintings for 
calendars shipped over to homesick GIs 
during World War II, today’s artists are more 
likely to make a series of personal images, to 
be shared online. There are fewer filters to 
pass through before their art is in front of 
thousands of eager eyes.

“I love a tattooed and pierced pin-up 
woman in her bathroom, with her pet 
octopus, as much as women coming from 

the worlds of burlesque,” says 
German artist Daniela Uhlig. 
“What I also find eye-catching 
and interesting is the melding 
together of different styles. 

Especially the mixing of cartoon styles 
within the classic pin-up form.”

Some things don’t change. Modern pin-
up artists are still trying to find the perfect 
pose, expression, line and shape. And 
when clothes, posing, lighting and 

expressions are dripping with 
sensuality, the demands of 
fans can become very 
specific. “I’m always asked, 
“How do you paint the hair, 

the skin?’” says French artist Serge Birault. 
His advice? “Take your time.”

SIRENS WITH STYLE
Andrew Hickinbottom, an English 3D artist 
who turned to the genre in the evening after 
his day job on children’s TV shows, says that 
pin-up is “an art form with many nuances.” 
If you go to pin-up to see boobs, it can be a 
base visual thing, “but I find that with 
stylised pin-up artwork there are so many 
ways to put across the attraction: cute, sexy, 

dark, light, curvy, slender, 
playful, serious, friendly or 
dangerous,” Andrew reveals. 
“There are a great deal of 
approaches to consider, 

With stylised 
pin-up artwork 
there are so many 
ways to put across 
the attraction 

ORANGE BUNNY
Melissa Ballesteros’s 

image is inspired  
by the photos of  
Dan Tidswell.
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P in-up art

SKIN AND HAIR
Serge’s pupils often ask, ‘How do you do the 
hair, the skin?’ But what about the latex?!

AIRBRUSH WHO?
Sorayama may be known for his airbrush work, 
but as Serge found out, he only uses it sparingly.

SHINE A LIGHT
This painting by 
Sorayama is French 
pin-up artist Serge 
Birault’s all-time favourite 
– the light playing on  
the shimmering water 
making a link with  
many of Serge’s pieces.

lot. I use pencils, tiny brushes and then, at 
the end, an airbrush.

Do you think the airbrush is a tool of the 
past? A lot of people still use it as a 
hobby, but few use it professionally now…
Perhaps fewer professional artists are using 
the airbrush now, when painting software 
contains similar filters. But I think there are 
still professional house or car painters, 
model kits makers, nail artists, and make-up 
artists who are still using the airbrush.

Do you teach?
No, I don’t. I have some tutorials on the 
DVD and in one of my books. If I have some 
free time, I’d rather create another painting.

Do you ever try digital painting? What do 
you think about it?
I’ve never tried digital painting and I can’t 
use computers. If I need to use it, I manage 
and create it to be done elsewhere. If both 
methods co-exist together and stimulate 
each other, I think that’s wonderful.

What advice could you give to pin-up 
artists who are just starting out?
The pin-up market is shrinking or being 
diluted, so if you’re thinking about making 
money as a pin-up artist, then I would say 
better not become one.

You’re my main influence and I’m not the 
only one – you’re an inspiration for a lot of 
artists or designers. Do you realise this?
If I’ve inspired any artists, I feel very 
honoured. I appreciate being the one 
whose footsteps they follow to find their 
own unique path. I think excellent sense is 
inspired by a greater sense and a new 
technique will be soon taken over by a 
newer technique. Serge san, let’s try our 
best to survive in this world of art. I think 
sense is the most important and a necessity 
in the world of art.

Where does your interest in pin-up art 
come from?
Oh, maybe just because I wanted to create 
my own goddess.

Can you explain why you’re so inspired  
by the world of fetish?
I like shiny stuff. I like metallic surfaces, PVC, 
membranes. I just feel they’re sexy. I think 
this particular fetish is a sort of disease that 
has affected a small number of people 
across the generations.

I’ve followed your work for more than  
25 years and your style has changed. Are 
you going back to vintage pin-up stuff?
Form my point of view my style hasn’t 
changed that much. I’m an omnivorous 
animal so I don’t even know myself what 
kind of poop I’ll produce.

What’s your main technical influence, and 
why did you start using an airbrush?
To me, photographs and the art of printing 
are my technical teachers. Using an 
airbrush is one tool that’s very efficient for 
small, key portions of each artwork, but it’s 
the icing on the cake.

For a lot of people you’re an airbrush 
artist, yet this isn’t your main tool
I‘m not that good at the airbrush. It’s just 
one of my soldiers I employ to create 
illustrations. It’s not the only soldier. If 
people take the time to study my works, 
they can tell that I don’t use an airbrush a 

WHEN SERGE  
MET SORAYAMA

Japanese pin-up master 
Sorayama was a big inspiration 
for the French artist Serge Birault. 
Here Serge speaks to his idol…
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and finding the right combination to 
suit the right girl is part of the challenge.”

For old-school artist Lorenzo Di Mauro, 
who moved from acrylics and airbrush to 

software in the 1980s, the 
digital age has ushered in 
new voices and new 
possibilities. “I love the 
funny irony of new 

burlesque, by pin-up art created by 
women, as artists or models,” he says.  
“I see 3D as something great that has 
emerged since art went digital, reaching a 
high level even in pin-up art.”

Rebeca cut her teeth painting strong, 
realistic fantasy female warriors before she 
discovered the magical world of pin-up. The 

saucy sculptures of Colin 
Christian, fellow 3D artist 
Andrew Hickinbottom and 
all the digital painters 
mentioned here gave her a 

glimpse into what pin-up was about: 
“Expression, emotion, imagination and 
especially good taste.”

Her art is a combination of beauty and 
terror – comic doll women dressed with 

realistically textured clothing, intricate 
tattoos and vertiginous high heels; sexy 
models, fully clothed. “Beauty is important 
in my work, but not only that,” Rebeca  
says, “I’m interested in addressing 
unconventional issues in an elegant way.  
I think it’s good to shake people’s minds.”

IMPERFECT PERFECTION
Whether borrowing heavily from the past 
or creating new octopus-S&M-nun 
imagery, “there is love coming through 
these women,” says traditional artist 

MISS MOSH
Andrew Hickinbottom is 

one of many current  
3D artists taking pin-up 

and adding different 
themes to it, as well as 

another dimension.

NIGHT PORTER
In this image Rebeca 
Puebla takes inspiration 
from 1970s Italian art 
house films of the same 
name, as part of her 
Twisted Dolls series. 

RED CALM
Jace Wallace’s personal 

portfolio is almost 
exclusively of women – his 

greatest inspiration.

I love the funny irony of 
new burlesque, by pin-up  
art created by women, as 
artists or models 
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P in-up art

1

TWISTED 
SISTER
Colourful tattoos, translucent 
skin and lace lingerie: Rebeca 
Puebla’s The Butcher’s Bride  
is a celebration of textures…

Rebeca Puebla discovered 
the world of fetish and 
BDSM around 2007, and 
soon afterwards started her 
series of highly striking 
images, Twisted Dolls. “It 

was a challenge because until then my 
work was quite realistic,” she says, “so  
I began to mix cartoon and realism. And I 
thought that making politically incorrect 
dolls in latex and impossible corsets look 
elegant was something new.”

Elegant transgression
I love to make provocative images 
with strong themes, but I don’t like 

to do typical exaggerated females (big 
chest, skimpy clothing). I love ambiguity 
and contradiction, such as a beautiful 
corset that’s impossibly restrictive. This 
idea might seem a bit seedy to some, so 
my challenge is to make the final result 
transgressive yet visually elegant.

4
Tattoo you

I spend a lot of effort 
getting the tattoos 

right. They’re important to 
the character’s story and 
must be dynamic, yet soft  
at the same time.

5
Lace lingerie

For the scene’s lighting 
I try different options, 

finally choosing one that 
creates the most contrast. 
Between the lace, laddered 
stockings and gold ribbon, 
there’s a lot of texture to 
pick out. 

2 6

Modelling the figure
Normally I make a base in 3ds Max 
and then use ZBrush for applying 

details. However, for this image I do 
more of the modelling in ZBrush, and 
leave a highly polished and smooth 
surface without too much detail, ready 
for the lace layer.

Final curtain 
Towards the end of my process  
I normally tweak the brightness, 

contrast and colour in Photoshop 
because I don’t usually achieve the 
right result using 3D software alone.
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UNDERCUT 2013
“I love undercuts. 

Growing your hair 
takes a lot of effort, and 

to shave a section of it 
takes balls. I think that 
contrast is pretty cool,” 

says Babs Tarr.

KEEP ON TRUCKIN’
“I’m approached by 
women to give them  
the vehicle to be the 
subject of their own 
fantasies,” says Les.

TRACEY
“My objective is to create 
an image that reflects the 
client’s personality and 
interests,” says Les Toil.

COMRADE VESNA
“This is a watercolour, no model was  
used, and it’s inspired from pulp cover  
poses and Ava Gardner,” says Maly Siri.  
“She’s mysterious and dangerous.”

Maly Siri. And when you truly love 
something, you can dispense with tired 
notions of perfection. “Perfection is boring 
as all get-out,” demands Adam. “An 
interesting juxtaposition of flaws that 
results in something desirable is more 
intriguing to me.”

Andrew agrees. “Pin-up is all about 
exaggerating features, and if you find one of 
those features to be unconventionally 

appealing – such as a slight belly, chunky 
hips or strong nose – then you don’t 
airbrush it out. You celebrate it.”

INSPIRATION FROM YOUTH
Even for artists who are redefining what 
pin-up can mean today, their respect and 
awe for the female form is rooted in 
nostalgia – not just of the halcyon 
cheesecake days, but of their own youthful 
discoveries. “When I was a kid growing up 
in Sicily, barbers gave customers pocket-
sized pin-up calendars,” recalls Lorenzo, 

BIG IS BEAUTIFUL
Les Toil’s love for big women has attracted fans who 
want him to turn their fantasy pin-up dreams into reality

“What inspires me is the positive feedback I receive from the 
clients that hire me to turn them into pin-up queens,” says 
Les, who’s been painting larger-sized pin-ups since the late 
90s. “Many of the women who approach me lead a life that 
aren’t glamorous, and these works of art enable them to 
vicariously live out a dream or fantasy. 

“Seeing themselves in the form of an empowered space princess or a 
mythical goddess often instils a stronger sense of self-worth for those 
that may have felt marginalised by a size-obsessed society. Receiving that 
type of positive feedback is fulfilling. I think most artists would like to 
know someone is viewing their creations as something to be admired and 
valued beyond its surface aesthetics.”

“so pin-up met my growing curiosity of 
women. Today the art gives me a flavour of 
the world of my youth.”

“When I was a youngster, I invented my 
own female heroine and drew stories 
featuring her,” says Aly. “Jacqueline was her 
name. She was a pirate, highwaywoman, 
Arabian princess – all sorts of things.”

Whoever is next to discover Aly’s gothic 
hell raisers or Rebeca’s 3D statuettes, one 
thing is beyond doubt: they’re in for a treat.

And they’ll be coming to the pin-up 
images on the artist’s terms. “The art  

A juxtaposition 
of flaws that results 
in something 
desirable is more 
intriguing to me 
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P in-up art
CATHY RAY
“Many of my favourite 
pin-up illustrators are 
female,” says Andrew, 
“Babs Tarr, Nic Ter 
Horst, Maly Siri, 
Genevieve Farley, 
Melissa Ballesteros...” 

PINK AMAZON
“I’m inspired by the fetish and BDSM world, and I love 
making elaborate latex dresses,” says Rebeca Puebla.

THE WEEKLY TRINQUETTE
Daniela Uhlig started painting in 2004 and has since 
grown to love depicting beautiful – and funny – women.

that I create is for me,” says 
Jace Wallace. “I have had  
lots of people criticise me  
for painting so many 
women, but in the end  

I am not creating art for them. My art  
is more than just eye candy because 
women are the greatest source of 
inspiration in the art world.” 
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PORTRAY A SASSY,
 TATTOOED PIN-UP
Loopydave brings his formidable illustration skills to the pin-up genre, 
and places the figure in roller derby gear because, well, why not?

ometime back I was 
commissioned to paint a 
poster for a documentary 
movie called This Is Roller 

Derby. I really enjoyed playing around 
with retro haircuts, sassy fashions, tattoos 
and attitude – all things that instantly 
lend themselves to fun pin-up art – and 
the brief here is to paint something like 
that again. 

In this workshop I’ll look at the steps 
required to paint a roller derby pin-up girl 

1 The brief
After some pencil concept roughs 

and feedback from the ImagineFX team, 
I’m going with a kneeling figure. This 
solves the challenges presented by the 
square format of the cover area: the viewer 
can see both the face and skates, and I can 
still keep the ‘camera’ tight in on the 
character. The skull is here for the 
narrative. If I cause a viewer to stop an 
extra second and wonder what the story is, 
it increases engagement with the image.

2 Colour rough
I do a quick colour rough in 

Photoshop over one of my initial 
sketches, because this pin-up will appear 
with other elements on the cover and  
I want to give the ImagineFX team an 
early feel for the palette I plan to use. The 
feedback is to lighten it a little and create a 
‘Death Dealers’ shirt logo – a really fun 
idea and nod to the late great Frank 
Frazetta. I love it!

3 Working sketch
Now I draw up a tighter sketch to 

paint over. All my sketches are on paper 
and then scanned in, partly because  
I work with a mouse in Photoshop but 
mostly because I love the medium. When I 
first started painting digitally my drawings 
included all the shading, light source 
information and so 
on. Yet over the years 
I’ve got better at 
solving image 
problems as I paint 
and my sketches  
have become  
much looser.

and possibly dating tips for the single, 
romantically inclined skull. A couple of 
notes before I start, though. I paint with 
the mouse. This often surprises people, 
but the explanation is fairly simple: it’s 
what I’ve gotten used to. Switching to 
digital painting many years ago, I tried a 
tablet, but at that stage there was an 
intolerable lag between what happened 
with the stylus and what happened on the 
screen, so I just stuck with a mouse. You 
are, no doubt, much more sensible than I, 

and use a Wacom or some other such 
device, but this will in no way affect the 
details and relevance of my workshop.

I’ll be using Photoshop CS3. It’s an 
older version, but budgets can be tight in 
the glamorous world of freelance 
illustration and I have no pressing reasons 
to update. The principles and details are 
still applicable to later versions and other 
programs such as Corel Painter.

So let’s strap on our rollerskates, adjust 
our elbow pads and hit the rink!

S

Windows on 
the world
View multiple copies of 
the project that you’re 
working on. In 
Photoshop click the 
Window menu and 
select Arrange>File 
name. Having one 
window showing the full 
layout leaves you free to 
zoom in and out on the 
other as you work. This is 
particularly useful when 
you’re fiddling around 
with fine details because 
you can see them in their 
full context in one 
window, and in detail on 
the other.
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began his 
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career as a graphic 
designer before 
switching to the wacky 
world of freelance 
illustration which, all in 
all, he considers to have 
been a pretty good move. 
http://ifxm.ag/loopy-d
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8 Using layers
The number of layers I use varies 

greatly from project to project. Sometimes 
I use a single layer, sometime lots more.  
I know that I’ll be using a number of 
layers on this picture, so I create folders in 
my Layer menu to keep them organised. 
For example, I put the layers related to the 
shirt in a folder called Shirt. It’s much 
easier to keep track of layers as I create 
more, and enables me to turn off whole 
sections at a time if necessary.

5 Setting up for painting
Here I remove the background white around my sketch by 

selecting it with the Magic Wand and then deleting it. Then I copy and 
paste the sketch on to a new document and choose RGB mode. I set the 
sketch’s Layer mode to Multiply and adjust its Transparency to 30 per 
cent or so. Now I’m ready to block in my colours in a layer beneath, all 
the while still being able to view the overlaying pencil sketch.

9 Where to start
After blocking in my base colours  

I start painting the face. It’s usually the 
first area a viewer looks at and often takes 
the most time and effort in the painting 
process, perhaps along with the hands 
and hair. I work on it for a while and the 
basics are now there, but it lacks some of 
the charm of the pencil sketch. I decide to 
paint the other ‘face’ – the skull and his 
floral arrangement – and come back to 
my roller derby figure later.

6 Blocking in the colours
Because I may need to adjust the colour of her outfit later on,  

I carefully block in each major item on a different layer: the body, shirt, 
skirt, protective equipment, skull and hair. Blocking in the basic 
elements can help serve both as a colour rough as well as creating areas 
that I can select later on by pressing Cmd+mouse click (right-click on a 
PC) on that layer in the Layer menu to help keep the edges clean.

7 Build on my initial lighting scheme
I work out the straightforward lighting on my colour rough. Once I’m sure that  

I want a strong rim light along her left-hand side, I need a filler light source at almost 
180 degrees so that the darker areas are the ones that butt up against the yellow of the 
backlight and create the greatest contrast. I roughly paint the yellow backlight as a 
separate layer and will gradually refine it as I finish each section of the painting.

4 Working size
I scan in my pencil sketch at approximately twice the required 

size – in this case it’s 600dpi at A4. It’s important to establish the 
maximum required dimensions with your client before starting and 
then, if your computer is capable, work at a even larger size – just in 
case. Image downsizing is easy, but scaling up a painting later leads to 
image quality issues that can cause anger, hate and suffering… 
basically, it’s the dark side of the Force on a monitor screen.

Layer selection

Ctrl+click (PC)

Cmd+click (Mac)

Clicking a layer creates a 

selection of that layer. 

Useful for keeping 

your edges tidy.
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14 Place the shadows
A common problem that I see with 

painters who are starting out is under or 
non-use of shadows. Shadows, more than 
anything, will give an object a sense of 
solidity, depth and relationship to other 
objects. I like to have at least a couple of 
points where there’s a sharply contrasted 
shadow/highlight area on a painting, so 
in this case I have them predominately on 
the neck and the front arm.

11 Flipping the scene
Back to the face. I flip the painting 

horizontally (a brain gets used to seeing 
things a certain way, so flipping an image 
can help highlight issues you may 
otherwise miss), create a new top layer and 
sketch out the proportional corrections as  
I see them in a bright colour. I flip the 
image back the original way, but now  
I have a new guide to fixing the problems.

12 Painting the outfit
Clothing can be tricky to paint 

convincingly. Fortunately, both the skirt 
and shirt aren’t complicated: I simply put 
small, sharp wrinkle lines on the pull area 
for the shirt and a couple of folds where 
the front leg interrupts the natural fall of 
the pleated skirt. I’ve painted these things 
many times before and I also have a 
wardrobe full of props and costumes and 
a mannequin in my studio that I have 
dressed in a similar outfit.

13 Range of skin tones
I create a swatch of colours that I refer to while I paint. Skin picks 

up the colours of adjacent objects, so I add yellow to the shadow where 
the arm is near the shirt, a more saturated orange where different parts 
of the body are near others (the neck and head, arm and arm pit, and so 
on). I notice the skin tone is a bit duller than I want, so I adjust the levels 
so that the skin is slightly brighter and then work with this new range.

10 Ladies and gentlemen, it’s Skinny Al!
I love painting skulls. I have a plastic one on my desk, called Skinny Al, that I’m 

referencing. It’s full of wonderful detail, although it’s a bit exaggerated in places, so I’m 
also looking at a few skull photos for more correct proportions. I use the standard Hard 
Edge brush set to a low Opacity – around 10 per cent – and build up the colours slowly. 
This will help create a smooth, yet slightly uneven surface.

Control your 
colour strokes
Regardless of which 
brush you’re working 
with, setting it on a low 
Opacity (say, 10 per
cent) and selecting
adjacent colours as you
paint will give you a
lovely smooth grade
without the ‘tearing’
caused when using the
Smudge tool and greater
control than a stronger-
flowing Soft brush.

In depth Tattooed pin-up
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17 Defining the hair
I draw the directional lines that  

I want the hair to follow on a separate 
layer, as a guide for painting individual 
strands as well as helping me work out 
where the highlights should go. I use a 
larger Soft brush to paint the highlight 
areas and then a 1-2 point brush to paint 
strands of hair. I use the Eraser tool to 
ease back the intensity of the dark hairs 
over the brightest areas and then a  
1-pixel Gaussian Blur to soften the single 
brush strokes a little.

18 Shirt logo
The Death Dealers logo is a tribute 

to Frank Frazetta, using similar facial 
proportions to those he liked (although 
these are lost a little when placed on the 
figure’s shirt) and a helmet and axe design 
from his Death Dealer painting. I apply it 
in a similar manner to that of the tattoo: 
inked artwork set to Multiply and then 
distorted a little using 
Edit>Transform>Warp.15 Painting hands

I have a thing about hands. They are one of the first things that  
I look at in a painting, and I see them as a litmus test of an illustrator’s 
skill and attention to detail. Consequently, I spend nearly as much 
time depicting a hand as I do on a face. I notice some scaling problems 
– it’s the price I pay for a quicker, looser sketch – so I scale the top 
hand down a bit, along with Skinny Al. 

16 It’s tattoo time
I use a quick but fairly effective 

method of adding tattoos. I open a scan  
of the tattoo design I’ve drawn, tint the  
line work with a hint of blue/green, add 
some basic colours with a Soft brush and 
then paste the artwork on to my painting. I 
set its Layer mode to Multiply, the Opacity 
to around 80 per cent and then I use the 
Warp function under the Edit>Transform 
menu to wrap it around her arm. I then 
run a little noise through it under the Filter 
menu, and we have a tattoo!

19 Final checklist
Towards the end of a painting, I sit 

back and run a critical eye over the whole 
image. I write down a list of all the things 
that aren’t quite right, harmonious or 
finished. This stage is critical and saves 
me from kicking myself later when I’ve 
sent the image off. I work my way down a 
list, darkening the top finger shadows, 
repainting the back shoulder a little wider, 
increasing Skinny Al’s smile, and so on 
until I’m happy the picture’s finished. 

Alter colour

balance quickly

Ctrl+B (PC)

Cmd+B (Mac)

A quick way to make 

image-wide  

colour changes.

Save regularly
I save and copy a
flattened version of my
painting’s progress as a
layer in a new file, usually
screen height, as I go
along. It’s useful for
reviewing the day’s
process, gauging how
long things take (which
is handy when it comes
to billing your client) and
comes in handy if you
ever need to create a 
tutorial later on.
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CREATE A STRIKING 
FANTASY TATTOO 

ince my early childhood I’ve 
been drawing, trying out 
every tool and medium  
I can get my hands on. In my 

teenage years I was an airbrush artist, 
then a photographer. But I’ve never 
attended art school and didn’t actively try 
to improve my drawing skills before  
I became a tattoo apprentice. Indeed, my 
introduction to tattoos was accidental,  
yet had a big effect on my life. 

There were already a lot of tattoos on 
me and by then I had lost my interest in 

S

From initial design considerations to inking on the body, tattoo artist  
Ien Levin shares his process for producing engaging skin art

How I create…

A TATTOO FOR A WARRIOR

1  Initial ideas
Once a client has given me a basic 

idea for an image, I’ve found that the design 
process becomes easier if you distil an idea 
into a few keywords or ‘tags’. My tags for this 
design are love, warrior, sadness, pain, death 
and war. In addition, my client asks me to 
place a straight line through the centre of the 
tattoo, and asks me to use solid black in the 
design if possible.

2  Use of symbols
When concepting, I prefer to use 

simple but powerful symbols. Here, a skull 
represents the death and warrior tags, with 
sadness and pain alluded to by an eye with a 
teardrop. Now I’m able to create the first 
raw sketch to see if the general composition 
is working. The top of the skull looks empty, 
so I cover it with roses, to represent love and 
to contrast with the smooth skull.

3  Finalising elements
Placing the solid black arrow at an 

angle creates some dynamism in the piece. 
While moving the teardrop to the bottom  
of the image enables me to increase the size 
of the eye, and in doing so gives the other 
elements room to breathe. To create the 
stencil of the tattoo, I recreate the separate 
elements, before merging and mirroring  
them in Photoshop.

photography. So I decided to try 
something new. I wasn’t aiming to 
become a well-known tattooist with  
a recognisable style. But I became 
fascinated with the art of tattooing and  
in turn worked as hard as I could to get 
where I am now.

My main inspirations are wildlife, 
science and engineering in all forms, 
religious/occult societies, the Middle Ages 
and mathematical/geometric art.

It’s difficult to explain my process 
when I design a tattoo. I have a discussion 

with a client, then I draw the design and 
tattoo the skin with my design. The 
process from start to finish can take any 
amount of time – like any art form, really. 
Painting a picture isn’t an exact science, 
and likewise neither is tattooing one  
of my designs.

Before taking the design into 
Photoshop, I use pencils and pens, rulers, 
compasses and tracing paper. Nothing 
special. It’s what you produce at the end of 
the day with these basic tools that should 
catch the eye. 
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Ien is the 
founder and 
creative 
director of 
Atelier Noir. 

He’s also an established 
tattoo artist as well as 
a product designer.
www.ienlevin.com
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Be prepared
A bad tattoo can look 
great when on the body, 
and a masterful tattoo 
design can fall flat when 
it’s in situ. The key is to 
create a design that will 
suit the specific area of the 
body where it’s going to 
end up. Ensure you know 
the design, size and 
location of the tattoo 
before taking things 
further. In addition, create  
a life-size tattoo design, 
rather than one that has  
to be scaled to fit.

Texture considerations
If you’re working in greyscale, you’ll 
improve your design skills by learning how 
to differentiate different parts of your 
tattoos, not only with shades but with 
textures. This will highlight the different 
surfaces. Try to keep the lighting balanced 
while playing with textures. Some areas 
can be solid black or white, feature smooth 
or whip shading, engraving-style line-
shading or even dot work (stippling).

Description
Don’t try to draw something 
that looks like a tattoo, and 
don’t limit yourself to so-
called tattoo styles. Don’t 
limit your imagination – mix 
everything and keep 
experimenting. The best 
tattoos looking nothing like a 
tattoo when they’re on paper.

Artist insight Create a tattoo
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GET AROUND 
ARTIST’S BLOCK  
Stop telling yourself there’s “nothing to paint” and see how 
James Zapata tackles a painting with no plan of attack

James Zapata
COUNTRY: US

James is a
freelance 
illustrator 
who’s done 
work for 

companies like Applibot 
and Wizards of the 
Coast. His influences 
include films and music, 
among many other 
things. He’s also 
developing his personal 
fantasy project titled 
Moon and Crow.   
www.jameszapata.com
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ver opened a canvas in 
Photoshop and been 
overwhelmed by the sheer 
emptiness of the big white 

rectangle? You might even have heard 
yourself saying, “I should have planned 
this out before starting.” 

Approaching a painting doesn’t always 
have to be such a precise and calculated 
exercise. You’ll find that exploring 
different techniques along the way can 
help add a whole new factor of fun and 

intrigue to the process that you may have 
not considered before. 

Of course, we shouldn’t forget the basic 
fundamentals. I don’t want you to 
interpret “experimentation” to mean 
“reckless abandon.” For you to take new 
approaches to your work you can’t forget 
core art elements: value, composition, 
perspective, colour and even narrative 
should always be kept in mind. These 
basics will be your anchor while you 
explore new territories in creation. 

E
I hope to introduce you to a few 

new ways of approaching design, 
including taking a freestyle attitude  
to the process. You’ll see how my initial 
intent and focus shift in the middle.

Painting is, in many ways, a journey  
of the mind. When I started out as an 
illustrator I often complained about 
having artist’s block. It would often be 
the case that I just didn’t know what I 
wanted to paint. Hopefully this workshop 
will help you get over that wall.

In depth Beat artist’s block
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5 Setting the mood 
After some extensive design work done over the initial shapes, 

I’m ready to dive into finalising the composition. I do this by creating a 
space in the foreground that I’ve decided to use as a ‘stage’ for a few 
characters I plan on adding to the mix. Next, I start to think about 
what colours will help describe the general mood of the image.

4 Starting the composition
I create a sense of depth by situating one of my objects in the 

foreground/midground and the other in the background. I also fade 
the bottom portion of the background shape to give a sense of 
atmosphere. I carry on with designing my foreground shape. Because 
it’ll be taking a bigger place in my composition than the background 
robot, I need it to be more readable. It’s the central figure and will 
therefore establish the overall design language.

Send in the 
clones
Clone stamping is a 
great way to quickly
generate a base for your
design. Have your Clone
Stamp tool selected with
whichever brush shape
you desire. Next, sample
an area of your painting
with the Color Picker
tool. Now you’re able to
clone that sampled area
anywhere. It’s great to
use as a base for
painting over later. Be
careful not to rely so
heavily on it that your
design ends up looking
like the same shapes
have been copied and 
pasted everywhere.

1 Taking the plunge 
I jump right into the painting by creating a circular selection and filling it with a 

gradient. From here, I like to use the Smudge tool with a Hard Round brush selected at 
100 per cent Opacity to push and pull the values in the object. I make sure to have 
Sample All Layers unchecked so that I only affect the object and no other layers. I’m not 
concerned with the end result at this point. Right now it’s just playtime.

2 Seeing shapes  
After a few minutes of playing with the shape I can form an opinion of what my 

object has become. I now look for shapes and lines. I like to compare this to seeing 
things in clouds. You start to put the pieces together and decide what direction your 
painting will take from here. I’ve decided this messy shape will become the head of a 
giant robot. From here, all my efforts will be geared towards that idea.

3 Repeating shapes
Once I’m comfortable enough with 

the shape to call it a robot, I set course to 
fill the canvas in an interesting way, and 
start thinking about some of the major 
elements that will make up my 
composition. I duplicate the robot head 
shapes and start tinkering with their 
general shapes to differentiate them. I do 
this by using my Smudge tool technique 
from before, as well as Clone Stamping.
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Color Picker tool

Alt (PC & Mac)

Use this in conjunction 

with the Clone Stamp 

to quickly create a base 

for your painting.



6 Picking your elements
I’ve decided, at this point, that the environment will be a 

volcanic area, so there will be lots of orange and dark browns. The sky 
will be dark for this piece, to help push the brightness of the under-
lighting on the machines. Up to now I’ve kept all the elements of the 
painting on their own respective layers, so managing the colours and 
values for each aspect individually is a straightforward task.

7 Lighting considerations 
Now that I’ve acquired the stage, I need to light it. I hint at the 

volcanic lava below by lighting the robots from underneath. 
Underlighting is a great way to express a sense of suspenseful drama. 
In this case, I want there to be a sense of mystery as to the purpose of 
these giant machines. When establishing your lighting, it’s important 
to remember that this step will influence the composition. So think 
carefully about where you have value shifts.

8 Cast your characters 
It’s a good idea to add a human character or two when painting a fantasy or sci-fi 

scene. It grounds the image and enables us to plug ourselves into that world. In this 
case, it’s also a good indicator for scale. Now we see the true enormity of these robots.  
I want to give the pilot some intrigue beyond her just being just a mech pilot, so I decide 
to give her a cool haircut. Now she’s got character!

9 Integrating your figures 
Because my characters pilot these giant robots it makes sense for their suits to 

follow a similar design language. I don’t worry too much about functionality, but I do 
want there to be a visual connection between the characters and their mechs. Some 
more clone-stamping here does the job of “sprinkling design” throughout the suits.

Rotate 

View tool
R (PC & Mac)

I use this to paint at angles

that would otherwise be 

awkward to reach.

In depth Beat artist’s block
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10 Adjusting the 
composition 

I’m unhappy with the way the 
composition feels like it’s “falling” to the 
right, regardless of there being a Dutch 
tilt, so I decide to push the right figure up 
in the canvas. I also increase the size of 
the mechs in the background, further 
adding to their size and filling more space 
in the canvas. In addition, I bump the 
values to give the image more contrast 
between each object. This generates a 
more defined composition.

11 Special effects 
Now comes the fun part. I begin by adding lava splashes behind the foreground 

layer with a Splatter brush set to a bright orange/yellow. I set this layer to the Linear 
Dodge (Add) blending mode and duplicate it once or twice, then merge those layers. 
You’ll find blending modes in the drop-down menu of your Layers palette. These effects 
help breathe life into your painting by adding a palpable sense of movement.

12 Make it juicy 
I intensify the brightness of the lava using the Color Dodge tool. I sample a mid-

value from the image and with a Soft Round brush with its Transfer set to Pen Pressure, 
build up my highlights and hot-spots. I think about where my lights will be the brightest 
and start from there. I also decide to give my characters more of a spotlight. The added 
contrast helps make them stand out from the background and surrounding elements.

13 Colour tweaks  
I’m nearing the end of my painting, so I decide to unify 

everything with some colour adjustments. For this step, I like to create 
a new layer with all the elements merged, so I select Edit>Copy Merged 
and then Paste. Now I have the entire painting on one layer. I can use 
this layer to adjust the colour balance (Image>Adjustments>Color 
Balance) and play with the sliders until I’m satisfied.

14 Neutralising your dark values 
I duplicate the merged layer and use a Gradient Map from here. 

To access Gradient Maps, navigate to Image>Adjustments>Gradient 
Map. Gradient Maps assign a colour to any number of values in your 
image. I select one of the default presets, then bring the Opacity of the 
Gradient Map layer down to about 12 per cent and set it to Lighten. This 
will push the colour contrast as well as lighten the darks with colour.

15 Finishing touches 
It’s time to wrap up the painting. At this late stage I like to 

tighten any loose ends. I adjust anatomy if I feel it’s a bit incorrect, 
clean edges where it’s needed, and so on. I feel that the bottom-left of 
the image is a bit bare, so I decide to add some dust clouds to give more 
depth in that area. I also light up some more of the main pilot’s torso, 
giving her more of a complete appearance. 

Reading your 
image
You should always
endeavour to keep your
objects readable in a 
composition. This means 
keeping a close eye on 
contrasts, both subtle 
and obvious. A good
way to remember this is
“dark against light and
light against dark.” If
you take care of your
values, especially in the
early stages of a
painting, then you’ll
have a much easier time
maintaining them
throughout the entire 
painting process.
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ANTI-OVERFLOW
As well as using the fill methods for flatting, 
there’s also an Anti-Overflow option in all of 
Manga Studio’s pen tools. This rather clever 
setting requires that you set the line art as a 
reference layer. But any time you draw 
colour – as long as you keep the centre of 
the drawing point inside the area you wish 
to colour – no colour will spill outside  
the line art, regardless of the size of the 
brush used. This makes it very easy to colour 
artwork which is a little more awkward than 
simple flat fills can cope with.

Next month – part 

two explains how to Next month pmont

render the colours in two explains ho texplains

your line art.

In the first of a two-part series, PJ Holden takes you through  
the process of “flatting” a page of line art in Manga Studio

1 Prep the layers
Set the line art layer to 

Monochrome via the Layer Properties 
window and then convert all white 
elements to transparent, by pressing the 
Black Only button in Layer Properties. 
Next, drop the Opacity of this layer 
down to about 60 per cent, which will 
help ensure that the flats are under the 
line art rather than running against it. 
Finally, create a full-colour layer below 
the line art and select it. This is now 
your ‘flats’ layer.

2 Fill your artwork with colour
Select Fill All Layers, set Close Gap to about 30 (this is the second box on the 

close gap settings) and set Area Scaling to .20 or so. Now fill in any large open areas  
of the artwork. You should be able to quickly flat a large proportion of the page in  
this manner. Just make sure that adjacent objects have different colours.

3 Mind the gap
Invariably, you’ll be left with lots  

of little gaps where the flood fill couldn’t 
reach. So select the Fill tool’s Close and 
Fill option. Ensure its settings are the 
same as Fill All Layers and draw lassos 
around any area of art that’s not filled. 
Manga Studio will now fill those areas 
with the foreground colour. 

adding a layer of simple flat colours to the 
artwork that the colourist can then select 
using the Magic Wand tool. These can 
then act as individual masks for sections 
of the artwork for the colourist to work 
on. Manga Studio offers a number of  
great tools for helping to speed up this 
somewhat mechanical process and in this 
article I’ll take you through this core 
digital comic skill.

he process of digital colouring 
a page of comics has, over  
the years, been simplified  
into two parts: flatting and 

colouring. Indeed, many professional 
comic book colourists will hire 
professional flatters to prepare their pages 
for colouring. 

Flatting a page involves taking the 
original black and white line art and 

FLATTING YOUR 
COMIC ART
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COUNTRY:  
Northern Ireland

PJ has been a 
professional 
comic artist 
for over a 
decade,

drawing predominantly
for 2000 AD on Judge
Dredd, Rogue Trooper
and more. He’s also 
the co-creator, with 
Si Spurrier, of 
Numbercruncher.
www.pauljholden.com



SOFTEN YOUR 
PAINTING STYLE
Enter the bittersweet and melancholy world of Fiona Meng, as she 
explains the techniques she uses to ‘softly paint’ a pin-up figure 

eople know me for my smooth 
renderings and graceful 
figures. After reading this 
workshop, you’ll know all my 

secrets of how to paint softly. 
Usually it takes me two weeks to paint 

a pin-up image like this one. The painting 
itself takes about a week. I then like the 
art to sit for a couple of days after it’s 
finished. During which time, I try not to 
look at or think about the painting, 
which enables me to come back to it to 
carry out the final alterations with fresh 
eyes. Ideally, I’d stretch out the alteration 
period for as long as a month, leaving the 
painting to rest for a good two weeks. At 

3 Reverse the painting
I’ve found that after painting for a 

while, sometimes I start to lose the 
freshness to the figure. When that 
happens I flip the figure horizontally, and 
see if everything is anatomically correct, 
or simply looking right. This step is 
essential if you’re painting a figure full-
frontal. The pre-defined shortcut in 
Photoshop is Ctrl/Cmd+T>right-
click>Flip Horizontal, but you could 
always define a hot key for this.

this point, my mentality is that if I can 
wait this long to just have a fresh second 
look, I’m going to make my artwork great, 
regardless of how time-consuming the 
changes may take. 

I end up doing 95 per cent of the 
painting in Photoshop, and five per cent 
in Corel Painter – in essence, the blending 
stage. The latter program does a 
wonderful job of mimicking real 
paintbrushes, but that’s not something 
I’m into, so I don’t use it as much. In 
addition, some larger brushes may take a 
while to render, especially toward the end 
of your painting process when you 
already have a large file.

P

2 Refine the anatomy 
I separate the figure and 

background onto two layers, then lock 
the background layer while painting on 
top of the figure layer and gradually 
merge the new layers down. I set the new 
painting layers as Normal for lit areas and 
Multiply for shadows. Using a Hard 
Round brush that’s set to 30 per cent 
Opacity and 60 per cent Flow provides a 
good amount of softness. Because the 
colour rough is very sketchy, lots of areas 
still need more definition and corrections. 
Before I spend a lot of time on details,  
it’s important to get the anatomy of the 
figure right first. 

Fiona Meng
COUNTRY: US

Experience of 
both Eastern 
and Western 
cultures meant
that Fiona

developed an elegant
hybrid illustration style.
She works as a freelance
illustrator and painting
instructor at the Academy
of Art University in
San Francisco.
www.fionameng.com 

1 Colour rough
I usually start my painting process 

by producing a colour rough. This gives 
me a general idea of how certain elements 
will be arranged in the composition and 
what colour scheme will work best. 
Sometimes I might even set the colour 
rough as a background and use it like  
an underpainting. 

Merge layers

down
Ctrl+E (PC)

Cmd+Mac

Keep your layers under

control by regularly 

merging them.
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Learn how to 
paint softly
I do two things to make 
sure that my art has a
smooth rendering. In
Photoshop I choose a
suitable brush, then set
the Opacity to 30 and
Flow to 60. Then I
practise the “paint 100,
give it 50” method. 
I paint on separate layers
at full Opacity, then
lower the Opacity and
gradually build things up
with dozens of layers.
Next, I bring the files into
Painter and use the Dry
Palette knife to smear. It
has to be the Dry Palette
knife – a Loaded one 
won’t work. 

5 Lay in the flats for the environment
As part of my regular painting process I use a Hard Round brush 

set at 100 per cent Opacity to block my flat colours in. This makes it 
straightforward to select and delete certain areas in the painting later 
on, using the Lasso tool. You could also use the Magnetic Lasso Tool 
for selection purposes. It’s not as precise, but it’s much quicker. 
Depends if you’re in a hurry or not! The Eraser tool is ideal for cleaning 
up smaller, fiddly areas.

7 Create a pattern  
on the clothing

I draw the line-art on a new layer first, 
and then set the mode to Multiply.  
I prefer to use a very fine Hard Round 
brush, between 3 and 5 in size, for this 
stage. Then I block the colours 
underneath the line layer. After the design 
of the drawing is finished I wrap it to 
match the figure’s curves, so it looks as 
though she’s wearing the dress, rather 
than being covered by patterns that have 
simply been pasted on top of her.

8 Paint the details
The forehead and the chin should 

be colder than the cheek, so I add a little 
green or blue to these areas. I apply darker 
green and purple to the neck because it’s 
partially in the shadows. The chest area 
should be colder and lighter in value 
because it’s rarely exposed in the sun. 
Except for the cheeks, where I use a Soft 
Round brush to add the blush, I use a 
regular Hard Round brush. I set the 
Opacity at 30 per cent or lower, and paint 
on layers upon layers, so my brush strokes 
aren’t evident.

4 Environment line-art
I create this the same way as I do the patterns on cloth, using a 

very fine brush so the line-work comes out gracefully. It may seem like 
a lot of work, but many areas are repeated. Just be sure to change the 
sizes and flip certain elements when copying and pasting. 

6 Hair decorations 
Now it’s time to work on her hair 

decorations. Initially, I’m not keen on 
tackling this because, frankly, there’s so 
much of it. But as it turns out, it’s actually 
not that difficult. I paint one pearl and 
one ruby, and copy and paste the rest. 
One thing to keep in mind when copying 
and pasting is to be careful about the light 
directions. All pearls must have a cohesive 
shadow side. 
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9 Soften the edges
I bring the Photoshop file into 

Painter and use a Dry Palette Knife to 
smear the edges. Note that if your 
original file format is TIF, you need to 
convert it into a PSD in Photoshop first 
before you bring it to Painter. Painter 
doesn’t recognise layers in TIF files. 

12 Check for tangents 
Tangents can bring unwanted attention to less-important areas 

in a painting, which can prove distracting to the viewer. In my 
painting, the phoenix’s wing and the hairpin have created a tangent, 
so I erase the tip of the wing.

13 Finishing touches
Now I just need to do a few touch-ups to make sure the painting 

has good colour harmony. I check to see if I have some foreground 
colour in the background, and some background colour in the 
foreground. Voilà! Now I have a finished painting. 

10 Edge control
After I soften everything, I bring 

the file back into Photoshop and refine 
some edges. I select the Easer and set the 
Opacity to 50 per cent to clean out some 
of the unwanted smear and give the edges 
a little “lost and found” feeling.

11 Background
I copy the colour layers of the 

phoenix and flowers, then flip the layer 
vertically and enlarge it. I place it at the 
top of the image where there’s some dead 
space, then lower the Opacity, apply 
Gaussian blur and set the layer mode to 
Multiply. I want to fill the empty space 
while keeping the environment cohesive.

Wrap selection

Ctrl+T>Wrap (PC)

Cmd+T>Wrap (Mac)

Ensure that any pattern

you create matches the

shape of the object 

it’s on top of.

In depth Soft painting style
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Aged poster treatment
After I’ve finished the characters, I put them 
on an aged poster background, to match the 
70s blaxploitation theme. I use old paper 
textures and a yellow/vintage white contour, 
and then play with the Opacity and layer 
modes. Usually Overlay mode works well.

DOWNLOAD RESOURCES http://ifxm.ag/oolala105
FINAL IMAGE • WIPS • BRUSHES

DOWNLOAD  
RESOURCES

 have a little weakness. I love 
drawing pretty girls. In fact,  
I love drawing pretty, bad-ass 
girls. I can’t help but draw this 

kind of character when I’m between two 
commissioned works and have some free 
time. It’s how I started this image. I just 
wanted to draw a strong, sexy character. 

A few weeks before, I’d seen a very 
cool blaxploitation movie starring Pam 
Grier, called Foxy Brown. Why not draw 
an homage to this character? At the 
beginning of the process, I didn’t have 
the idea to make a poster. I just wanted 

I

Guillaume Poux catches the blaxploitation vibe of the 1970s 
with this study of a gun-toting female character. Can ya dig it?

PHOTOSHOP

CUSTOM BRUSHES: 
CHRIS WAHL

I use these special 
brushes made by Chris 
Wahl for the hair, fur and 
the aged feel of the 
poster texture.  

How I create…

A FOXY FEMALE

1  Character sketch
I start with a very quick and rough 

sketch. For this one, it’s a digital sketch. 
Generally, I prefer to use a pencil and paper 
which I then scan, but I didn’t have any paper 
to hand. When I draw my sketch, I have a very 
loose line and I often let my hand command 
the drawing. The most important thing is to 
get an interesting shape, even if the 
character’s posture is relatively straight.

2  Strong shapes
For the colour version of the 

painting, I begin with the general shapes 
of the characters. I use the Pen Tool and 
make the shapes. Afterwards, I block this 
shape and paint the different elements, 
such as the jacket and boots. I choose very 
simple colours: black, red and white. The 
image must catch the eye of the viewer 
and have strong contrast.

3  Light and shadows
At this point the colours are almost 

finished. The important elements of the 
composition, such as the hair, fur and face, 
and the thin contour line on some areas, are 
also in place. Each element sits on its own 
layer. It’s at this point that I notice some things 
need to be improved and reworked. I’m going 
to add some lights and some shadows to 
increase the contrast.

DRAW A STYLISED 
DYNAMIC FIGURE 

to draw my version of Foxy. Then my 
girlfriend suggested that I add a hyena to 
the composition. Her reasoning was that 
packs of hyenas are generally led by a 
dominant female. I found the idea really 
cool, and perfectly in tune with the idea 
of a strong woman character.

As I do for almost all my images,  
I searched a lot of references for the 
clothes and the hyena, and uncovered a 
lot of inspiring old blaxploitation movie 
posters. Thanks, internet!

I have the idea and the references – 
now it’s time to begin my image… 
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COUNTRY: France

Guillaume,
aka El Gunto,
is a freelance
character
designer and

illustrator. He works for
many publishers as an
illustrator and creates
concept art for the
entertainment industry. 
www.elgunto.com
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Painting leather
I want to depict a shiny material for the character’s 
boots, such as leather or latex. My technique is 
very simple. After all, you don’t have to be ultra-
realistic in cartoons – you just have to suggest 
shininess. I place a very white spotlight on one side 
and slightly reflect it on the other side. Simple!

The silhouette
Keep it simple! A character’s 
silhouette must be easily 
readable. When you paint a 
cartoon-like figure, you have to 
push the shapes and have an 
asymmetrical outline, which 
will give your drawing added 
dynamism. So place a straight 
line against a curve, a fat shape 
against a thin one, and so on.

Wild hair
For this important part of the 
character, I use a custom brush 
from Chris Wahl. Find them at 
http://ifxm.ag/c-wahl. I love  
the rough and wild effect it gives 
to the hair. It contrasts nicely  
with other areas of the drawing, 

which are smoother and feature 
flat colours.



BRUSH SKILLS  
IN PHOTOSHOP
Geoffrey Ernault showcases his method of generating 
an image from random brush strokes in a short time

or me, the best part in doing 
concept art is finding new 
ideas and solving design 
problems. I love painting 

anything that deals with sci-fi and 
fantasy, and more generally anything that 
gets my creative juices going. I use mostly 
Photoshop, but also enjoy mixing other 
software into my workflow, such as UDK, 
3ds Max or ZBrush.

When I started discovering Photoshop, 
I often ended up in front of a blank white 
canvas and didn’t know what to paint. 
And when I did, I would have trouble 
finding an interesting idea, and this 
could become frustrating and 
intimidating. Five years later, I’m now 
using a supercool method that enables 
me to always have something I can work 
on and develop. 

F
This method is useful when you have 

time to paint, but either have nothing 
specific to work on or just can’t come up 
with ideas. It also trains your brain to 
recognise shapes and create compositions 
quickly, which is also useful. 

Bear in mind that some of the methods 
shown here don’t always work on detailed 
images. For instance, when I work on 
more final images, my layers are much 
more organised, and I spend a lot more 
time on finding the right composition at 
the start of the process. 

In addition, even though it’s great to be 
able to do an image in under a couple of 
hours, it doesn’t always help you develop 
your core skills. To be able to do this well, 
you need first to know how to do things 
the slow way. This is why mastering the 
fundamentals is essential!
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1 Generating chaos 
The first thing to do, of course, is 

generate chaos! Simply start off with a 
white canvas, and slap on a good amount 
of brush strokes. Usually, I use a simple 
brush with a bit of texture, but mostly 
Opacity controlled by pen pressure. You 
don’t even have to watch the canvas! Just 
paint some brush strokes, and vary the 
pressure that you apply with the stylus. 

2 Adding a  
ground plane

When I’ve got a couple of shapes and 
brush strokes on the screen, I select the 
Lasso tool and take a random part of the 
image, which I deform to have a texture 
set in the correct perspective. This will 
help me see the ground plane in the 
image, enabling me to work around it. 
This also helps when setting the camera 
height, depending on how you place it. 

3 Reading shapes and finding the idea
After a while – 30 minutes, an hour, or more if I have the time 

and haven’t found anything yet – I usually start seeing shapes that 
remind me of something. “Hey, this looks like an alien structure!” is 
what I think when I see this weird shape on the left. When you start 
getting the idea, start refining it and working a bit more in the 
direction of the idea you have. If you see a forest, for example, start 
adding some trees! 

4 Adding lighting, 
refining shapes

I like to add light early on. To do so, I use 
the Dodge tool with a Soft brush. Just 
paint with it where you want to add light, 
and Alt-click to add shadows. I usually 
leave the tool set to Midtones and keep 
Protect Tones checked. Try not to increase 
the Exposure too much, or you might 
burn your image. I usually use this trick 
early, as the tool can burn an image easily. 

5 Getting more  
chaotic details

To create more details easily, simply copy 
parts of your image with the Lasso tool, 
and turn them around and scale them to 
generate new shapes. Compare this step 
with step three. See that new structure on 
the left? It comes straight from the other 
one right next to it! I also like to  copy the 
whole image and stretch it a lot, then set 
the copy layer to Multiply or Screen mode 
to add a bit of detail to those open spaces.

6 Checking the 
composition

At this stage, I want to be sure that the 
composition is good before jumping into 
colours. Just zoom out, look at the whole 
image and see if it works. Is it dynamic? 
Do you have interesting shapes? Is there a 
focal point? Is the perspective right? 
Solving these questions early on saves a 
lot of time later. 

PHOTOSHOP 

CUSTOM BRUSHES

I use as many brushes as
I can, and never rely on a
single brushpack. Most
of the time, I use a mix of
brushes by Levi Peterffy,
Maciej Kuciara, Jaime
Jones, Sergey Kolesov,
Luke Mancini and
Shaddy Safadi. The best
way to learn about
brushwork is to change 
your brushes as often as
possible, and try to copy
pictures by using any
kinds of brushes. For
instance, try painting
clouds using brushes
that you would use to 
create rocks!
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9 Sculpting shapes with light
Now that I have my light source, I keep it in mind for the rest of the image. The 

key trick here is to render the image as if you were a computer: visualise the light source 
in your head in 3D, and figure out where it hits. Of course, you can cheat a bit to add 
some highlights here and there, even if it’s not always 100 per cent realistic. Here, I add 
some highlights on the structure in the background to define the structure, and also at 
the bottom left so that the little spikes will stand out more. Be sure to add volume to 
objects by keeping their shape in mind and thinking how light hits them. In addition, 
try limiting the main lit area to a specified area of interest.

7 Adding colours
This is the fun part! Usually, when 

I start thinking I have something solid  
I can work with, I drop in a picture or an 
old painting of mine to get some colours 
and textures. You don’t need anything 
that looks like your subject – the goal here 
is to get some noise going, and produce 
some happy accidents. I usually set the 
image on top to Multiply, Overlay or Soft 
Light mode, but be sure to check all the 
layer modes – you could get some nice 
surprises and results. After this, I just 
sample colours from the result, because 
the colours mix with the values. 

10 Adding lighter areas 
to the painting

Although I love using Layer blend modes 
to add light, I also like using Curves. 
Using a Curves adjustment layer, I can 
level everything up and brighten or 
overexpose the whole image. Now, I select 
the Curves layer’s mask, and Fill it with 
black so that the adjustment is hidden. 
Then I simply use a Soft brush to paint on 
the mask with white in the areas where  
I want to have some spots of light or light 
beams in the image. 

8 Adding light
Now that I’m happy with the colour palette, I just sample from 

it and start repainting everything little by little. The key here is to adapt 
it so that the values aren’t destroyed. At the same time, I start adding 
light. I simply define the area I want the light to come from, pick the 
value that’s there, and add more brightness and a bit of saturation to it. 
You can also do this by sampling the colour, then painting it on a layer 
set to Screen, Lighten or Color Dodge. Again, depending on the 
situation, the Dodge tool is also useful.

11 Detailing the 
structures and scale

In a landscape with weird shapes and 
structures, you want to be sure that the 
scale reads right. For this, I just add a 
humanoid character, or a design that can 
be seen in everyday life: something like a 
tree, a lamp post or a car will do the trick. 
The eye then sees the size of this object, 
and can compare it with the rest of the 
environment. I also start refining the 
shapes so that they have a bit more  
flow and connection with each other. At 
this stage, I add some light circles in the 
background, to indicate that there’s a light 
source from behind there. I use a Color 
Dodge layer for this. 

Flip it!
Be sure to flip your
image horizontally
anytime you can! This
will refresh your view of
the image and allow for
clever image correction.
It’s also useful for seeing
new shapes, and of 
course getting ideas! 
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Colour palette 
A (PC & Mac)

I’ve set this to A, so I canpick a colour quickly. Anykey on the left will do, ifyou use the brush in 
your right hand.



12 Producing a warmer image
I try to always stay close to the mood I want to go for in my image, linked to the 

idea. Here, I think it would be nice to have a sort of warm desert planet. For this, I use a 
Color adjustment layer, and add more red and green to the shadows. I do the same for 
the midtones. I also use a Hard Light layer, on low Opacity, with a warm orange. This 
layer is then erased to leave just the top of the image more orange than the rest. 

15 Hide it in the mist! 
A good trick to save time is to introduce areas of smoke or mist. 

You can do this simply by using a brush with scattering on it (press F5> 
Scattering), using a low Opacity and Flow, and paint on a Screen layer. 
This technique can also be used to add depth and haze. 

16 Go wide 
When I’m near the end of the 

image, I apply a Wide Angle filter 
(Filter>Adaptive Wide Angle). Just play 
with the settings and you’ll see how it 
transforms your image by stretching the 
sides, which creates a sort of perspective 
effect that adds depth. 

13 Playing around  
with light beams

You may have noticed by now that I love 
playing with light. Something else that  
I use to define light easily and play with 
focal points is adding light beams. This 
also enables you to add highlights on 
shapes to give them more volume. In 
this example, I add highlights on the 
structure at the top, and also create a bit 
more visual interest to the ground on 
the right. It also places the focus back on 
the structure on the left, rather than on 
the one in the background. 

17 Final filters and effects
Now all you have to do is add that little crisp, photorealistic 

effect. To do this, I use Smart Sharpen (Filter>Sharpen>Smart 
Sharpen). On top of this, I add a noise layer to blend everything 
together: I simply go to Filter>Noise>Add Noise, and when the noise is 
in place, set the layer mode to Soft Light at around 10 per cent Opacity. 
I also stretch the image horizontally slightly, to produce something a 
bit more dynamic. Be careful, though – just like the Adaptive Wide 
Angle filter, this might end up cropping part of your image! 

14 Small details and particles
Little bits of visual interest enable me to give the impression that the whole 

image is detailed. Remember, it’s a speed painting, and you want to give the impression 
of a final image. Here, I simply created small vegetation elements to add detail to 
structures and the ground, and dust particles to give the light beam extra definition. 

Working on the 
big picture
Always work at a high
resolution, and upload or
share your image at a
smaller size. This will
force the viewer to focus
on the overall image, and
not details. This is also
why you want to always
work zoomed out. An
image that works
zoomed out will still
work when you zoom in. 
The opposite isn’t true. 
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Horizontal flip

Ctrl+Shift+1 or Ctrl+< 

(PC & Mac) 

I use this to flip the image

often to check the

composition and spot 

any mistakes.



ON SALE NOW! Order your copy today at www.zinio.com/imaginefxspecials

Master the core skills of digital art with our team of professional artists. 
Featuring 117 bite-sized tutorials!



Art directors and illustrators share their 
insight and inspirations on book art

The art of book 
illustration
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SAVE UP TO 45 PER CENT OFF THE 
COVER PRICE OF IMAGINEFX. 
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Rising Star Wylie Beckert shares her stunning illustration secrets www.wyliebeckert.com

Featuring…

Top children’s book 
illustrators share their 
industry know-how.

Picture books

How to draw the most  
imaginative creatures with 
Cory Godbey. 

Creature creations

We dive into the beautifully 
crafted sketches of the 
celebrated fantasy artist. 

Brian Froud 

How does the multi-award 
winning artist create his art? 
Find out next issue…  

Tony DiTerlizzi
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INJECT SOME 
HUMOUR INTO A 
FANTASY SCENE
Therese Larsson shows you how to amuse the viewer in  
this storybook illustration from a classic children’s fairytale
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ver the course of this workshop 
I’ll demonstrate the 
techniques I use to create 
digital storybook art from 

scratch. I prefer to have a more traditional 
approach to my art, using underpainting 
techniques and painting on as few layers 
as possible, and sculpting light and shape 
using some of my favourite brushes that 
I’ve acquired over the years. 

I like to use brushes that emulate real-
life media, such as oil colours or chalky 
pastels. I believe that textured brushes 

O
add a lot of life to a composition, and that 
there’s beauty in an object that doesn’t 
look overly polished and smooth. 
Textures can also make an illustration feel 
more detailed than it really is, saving the 
artist a lot of time. 

I plan to depict a scene from the well-
known children’s story of Little Red 
Riding Hood, but with a funny twist to it. 
Dog owners will recognise the way 
canines can become oblivious to their 
surroundings and be completely 
mesmerised by food, and it’s always good 

to have people be able to connect to the 
art by showing scenes which are funny in 
an everyday way. 

People love to feel and think when they 
look at art, so try to tell stories with your 
illustrations. It’s more important to have a 
great idea presented in a fairly 
straightforward manner, than produce a 
more advanced painting that has no story 
to it. So before you start, give yourself 
time to think. What’s your theme? Can 
you add a twist to it? How do you make 
people connect to your art?
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Therese 
Larsson
COUNTRY: Sweden

Therese is a 
freelance 
illustrator 
based in the
Swedish

capital Stockholm.
She has worked with
clients such as Google,
Disney, Adidas and 
Coca-Cola to name but 
a few. She says her
specialities are animals
and character design. 
http://ifxm.ag/tlarsson



1 Sketchy beginnings
I start off by creating a new document. I like to work big: around 8,000-10,000 

pixels wide or high, depending on the format, and always at 300DPI. All sketching is 
done on a new layer over the background layer, so that I can easily paint underneath it.

2 Start the underpainting
I choose the background layer and fill it entirely with a rather neutral forest 

green, which will serve as an underpainting. On top of that, I pick a Soft brush, increase 
its size and start blocking in different tones of brown, green and blue. I like to keep a 
traditional approach for my digital art, so I try to always go from big to small, so that 
the finest details are saved for last. Once I’ve blocked in the main colours, I change 
brush to a Chalky one and start to flesh out the environment, sculpting out the general 
shapes of the backdrop. It’s still too early to start detailing.

3 Refine the light
Once I feel that I have a good base 

painting I start to refine the light. When 
creating light I usually switch between 
three layer styles, depending on how 
harsh I want the light effects to be. Those 
layer styles are Overlay, Soft Light and 
Hard Light. I do a lot of trial and error, 
letting my mind tell me when something 
looks off or not. Reducing the Opacity of 
the lighting layers works, too. When 
lighting the scene, I go for two separate 
layers: the first one is set to Overlay and 
the other is set to Hard Light. When 
working with light, I always use a big, Soft 
brush. Only for direct light would you 
want to use a Hard-edged brush.

4 Blocking in colour
I let the background rest a bit once 

I’ve blocked in the basic light, and create a 
new layer on which I’ll start to block in 
the wolf. To get a better overview of the 
painting, I go to Window>Arrange>New 
window for redridinghood.psd. That way 
I get a new window of the same painting, 
which I can scale down to see the bigger 
picture. The same technique is applied to 
the wolf as to the background. I start off 
by painting in a greyish brown silhouette 
of the wolf, that serves as the main 
underpainting. From that base, I go to 
more grey tones as well as to more brown 
tones, as I start to chisel out the shapes.  
I try to avoid black and white, but always 
work with richer tones. White and black 
are best kept for absolute extremes, such 
as highlights in eyes. 

5 Blocking in light
When it’s time to block in the light for the wolf, I add a new layer 

that I link to the base wolf layer by pressing Alt and clicking in between 
the two. I set it to Soft Light and begin working in the basic light. I 
suggest trying Overlay, Soft Light and Hard Light, and seeing which 
one works best. Think about where the light is coming from, work in 
more yellow light where the sun will be hitting, and some green 
bounce light on the surfaces where direct sunlight doesn’t hit, but 
which is affected by the surrounding green light of the forest. Once I’m 
happy with how the image is developing, I merge some of my layers by 
going to Layer>Merge Layers or by pressing Ctrl+E. For personal art,  
I try to have as few layers as possible; my final art is almost always one 
single layer. But for professional work, it’s better to keep a couple of 
layers in case the client wants to change certain elements. 

Assess your 
image’s values
A good contrast of value
in an illustration is very 
important. To see how 
well your art reads to the 
viewer, go to Layer>
New Adjustment Layer> 
Black & White. If your 
illustration looks good in 
black and white, the 
values are well balanced 
and the art will work in 
colour as well.

Adding contrast

Ctrl+L (PC)

Cmd+L (Mac)

To add some extra contrast 

to your painting, use this 

shortcut to increase 

the levels.
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6 Adding details
Once the basic light has been 

painted in, I start to work more on details. 
I paint in big fur clumps using a rather 
unrefined Chalky brush and then 
switching to something more smooth and 
tight for painting individual hairs. If you 
have a solid base to work from with 
correct light and blocked-in shapes, you’re 
able to spend less time on details yet still 
achieve believable results. Paint as if you 
were brushing an animal using a hair 
brush, following the direction of the hairs. 
Study photos and real life. Fur flows in 
different directions depending on where 
you are on the body, so pay attention! 

7 Changing brushes
I leave the wolf temporarily and 

start to block in Little Red Riding Hood.  
I use a softer brush for the character. Pick 
your brushes according to what you’re 
going to paint: think about what the 
surface would feel like? Is it bumpy and 
gritty, or soft and smooth? When I paint,  
I note the colours and light of the 
environment. For example, her hand is 
shaded from the sun as she presses the 
wolf’s nose. So it’s not lit by yellow light 
from the sun, but by green light that has 
bounced from the surroundings. 

9 Merging layers
Now that all the separate elements 

have been placed on the painting it’s time 
to merge all my layers and start on the 
detailing process and applying a final 
lighting scheme. The reason why I prefer 
to work using as few layers as possible is 
to that I can unify the whole piece into a 
scene where the elements feel as though 
they are one. I use the Color Picker tool a 
lot during this stage, which also helps to 
unify the art. 

Set up two 
windows
To get a better overview 
of the whole picture 
when you are down in 
detail mode, create a 
new window by going to
Window>Arrange>New 
window for filename.psd. 
This means you don’t
have to zoom out to see
how the details affect the
art from a distance. It’s
very easy to get lost in
detailing and lose sight 
of the bigger picture.

Merge layers
Cmd+E (Mac)
Ctrl+E (PC)

Select the layers you want to merge and quickly make them into one.

8 Thinking in 3D
Little Red Riding Hood is further 

fleshed out and her picnic basket, bottle 
of milk and apple is also painted in. Try to 
think in 3D when you paint. What surface 
areas will receive more light? How is light 
broken up when filtered through glass? 
How does an apple shine? Study real life, 
and try to learn the principles behind the 
effects. This will enable you to apply them 
to other scenarios.

10 Colour adjustments
Little Red Riding Hood is looking 

slightly too yellow, so I add a new Color 
layer. Then I pick a red tone and start to 
paint on her skin to remove some of that 
yellow. I still want to keep some of it, so  
I reduce the Opacity, which ensures I still 
keep some of that glow. Let your eyes be 
the judge: what looks good? If you feel as 
though you’ve stared at a painting for too 
long, flip it by going to Image>Image 
rotation>Flip Canvas Horizontal. That 
way you’ll reboot your brain and can spot 
mistakes more easily.

DOWNLOAD  
RESOURCES

PHOTOSHOP 

CUSTOM BRUSHES: 
BRUSH_3

BRUSH_4

This is my favourite 
brush. It has a nice 
texture and feels like 
working with traditional
media. It can be used for
both early, rough 
underpainting as well  
as for details.

This is a good chalk 
brush for blocking in and 
working with during the 
underpainting stage. 

11 Bringing it to life
Now I just basically keep detailing 

and drawing all the little bits that make 
the art come alive. Stray hairs pointing in 
different directions, whiskers, mushrooms 
growing on the mossy rocks… little details 
here and there. Small points of secondary 
interest are good too, such as a little owl 
and a squirrel that help keeps the viewer 
interested and leads them around the 
composition. This phase is really the last 
step – I’m tying everything together into 
one finished illustration. 
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Magnificent Good AtrociousPoorOrdinary

The latest digital art resources are put 
to the test by the ImagineFX team…

RATINGS EXPLAINED
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Artist’s  
Choice Award
Art resources with a five-star 
rating receive the ImagineFX 
Artist’s Choice award!

SOFTWARE
92 Procreate 2
With a new engine, incredible 
features and a whole world of brush 
customisation options, the world’s 
best iPad art app has just got better.

BOOKS
94 The Art of Cloudy with 
a Chance of Meatballs 2
Go behind the scenes on the  
joyous animation feature.

95 Digital Painting 
Techniques: Volume 5
Discover digital techniques from top 
artists in the new 3D Total book.

95 The Art of Assassin’s 
Creed IV: Black Flag
This book of concept art is a  
real chest of secret treasures.

TRAINING
97 Australia’s Age  
of Dinosaurs
James Gurney offers a brief but 
nevertheless rewarding look into a 
demanding natural history project.



Price $5.99/£3.99  Company Savage Interactive  Web www.procreate.si  Contact feedback@savage.si

Pablo Uchida used 
Procreate’s curves 
feature in his curvy 
creation Prospace.

Matt Hubel’s redesign 
of Teenage Mutant 
Ninja Turtles’ Shredder 
began in Procreate, 
before being taken into 
Photoshop for a lick  
of visual gloss.

Procreate 2
QUANTUM LEAP With a new engine, incredible features and a whole world of 
brush customisation options, the world’s best iPad art app has just got better…

hen the iPad was released 
some three-and-a-bit years 
ago it changed everything. 
Software companies saw 

their chance to get in bed with the 
new shiny techslate. Autodesk’s 
SketchBook Pro proved to be a 
decent piece of software for quick 
drawings, Adobe created casual 
vector-based drawing with Ideas, and 
Ambient Design translated ArtRage 
from the desktop to the tablet.

Yet one piece of software fared 
better than all of them: Procreate. 
Created by Savage Interactive, it was 
written exclusively for the iPad so the 
Aussie developer could concentrate on 
making a great art program without 
the faff of Android cross-compatibility 
or rescaling it to fit on an iPhone. The 

W
app was well-received and bagged an 
Apple Design Award for its natty 
integration of hardware and software.

Procreate 2, then, has a certain 
amount of prestige to live up to – and 
we’re pleased to say it’s improved on 
perfection. The most immediately 
noticeable change is to the aesthetic, 
which is brought in line with Apple’s 
iOS7 translucent update.

Fire up a blank canvas and you’ll see 
the option for 4K, another new feature. 
This size is becoming more prevalent in 
the world of digital art, but it’s rarely 
used as a preset on tablet apps 
because of the size of the files involved. 
Thankfully, Procreate utilises the 64-bit 
power of the latest generation of iPads 
(Air and iPad Mini with Retina) to 
handle epic compositions.

Reviews
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ARTIST INTERVIEW

MATT
HUBEL

Matt explains why Procreate is 
the only iPad art app for him

Matt paints in 2D and 3D, 
and is currently working as  
an illustrator in the video 
games industry.

www.matthubel.com

What do you like about the new 
version of Procreate?
I think that the brush creation 
engine is amazing. It’s incredibly 
simple to tweak settings on existing 
brushes to achieve the exact feel 
that you want, and creating a brush 
from scratch couldn’t be simpler or 
more flexible. If you pair that with 
one of the many pressure-sensitive 
styli available, then you have a 
formidable drawing app.

And what’s your favourite 
improvements in Procreate 2?
It might seem like a small addition, 
but adding the Curves, Color 
Balance and Hue and Saturation 
tools is a huge thing for me. Colour 
correction is an integral part of my 
work flow and it’s great to see it 
integrated so beautifully.

Do you use Procreate alone, or 
do you paint with it alongside 
other software?
I tend to use Procreate on a more 
casual level. I like it for painting 
thumbnails and sketching ideas 
while I’m on the go. I’ll then take 
those sketches and finish them out 
in Photoshop or Painter. I still like 
having a workstation to sit at while 
I create.

Is there anything you’d like to 
see added to Procreate?
I would love to see Procreate have a 
feature similar to the Gradient Map 
adjustment layer in Photoshop.  
I use that all the time for quickly 
colouring a greyscale sketch.

How do you think Procreate 
compares to the other iPad art 
apps on the market?
When compared to other apps, 
there’s no competition. Procreate is 
ridiculously affordable, it offers the 
largest canvas size; the best, easiest-
to-navigate user experience and 
user interface design, and the best 
brushes by a mile. I’ve purchased 
all of the other art apps out there 
and they just collect digital dust.

The software also taps into the 
powerful GPU to provide some 
awesome effects that you’d usually 
only find in high-end desktop 
software. Options for Gaussian Blur, 
Sharpen, Noise, Color Balance and 
Curves are all available to give your 
images a bit more (or less) of an edge, 
and once applied they can be adjusted 
instantaneously by swiping your finger 
across the screen.

Brushes are Procreate’s forte and 
even these have been made a lot more 
granular. The level of customisation is 
incredible: each brush has six menu 
pages so you can adjust shape, grain 
and dynamics. We found it best to 
simply fiddle with the sliders, but there’s 
a comprehensive information screen 
available for each. That Procreate has a 
vibrant Photoshop-esque brush sharing 
community says it all.

The only disadvantage to all these 
new features is that it lags a little on our 
first-generation iPad Mini. It’s still 
smooth and sharp, but zooming and 
moving a 4K file around results in 
noticeable pauses and choppiness. But 
it’s such a refined and gratifying app 
that it’s quite possibly the best reason in 
the world to upgrade to a new iPad. 

 Brushes are 
Procreate’s forte 
and even these have 
been made a lot 
more granular 

You’re given plenty of 
options to achieve the 

perfect brush stroke  
in Procreate.

Adjustment tools such 
as Curves and Color 
Balance mean you 
don’t necessarily have 
to export your work 
into another art 
program to finish it off.

Patipat Asavasena’s art was created in Procreate, 
despite having a polished Photoshop look.
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Software Procreate 2

Features
 iOS 7 redesign

 64-optimisation for 

iPad Air and iPad Mini 

with Retina Display

 GPU-accelerated 

filters and adjustments

 Gaussian Blur

 Sharpen

 Noise

 Hue, Saturation & 

Brightness

 Color Balance 

(Highlights, Midtones 

and Shadows)

 Curves (Gamma, 

Red, Green and Blue)

 Includes latest SDKs 

for all styluses

System 
Requirements
iPad: iOS 7 or later

Rating



Author Tracey Miller-Zarneke  Publisher Titan Books  Price £30  Web www.titanbooks.com  Available Now

course, with Flint. This gives the reader 
some interesting background to the 
design decisions behind them, and is 
backed up with gorgeous renders, and 
a mixture of storyboards and invention 
designs (in Flint’s case, anyhow).

There’s some excellent work by  
Andre Medina, with his – deep breath 
– Forkenknifenspooniator piece being 
a top pick. Steve (Flint’s pet monkey) 
and Earl Devereaux (voiced by Mr T no 
less) are character designs to look out 
for. We also adore the posters of 
Chester, who’s the CEO of Live Corp.

This chapter concludes by 
presenting some hilarious early 
sketches of Barb – the orangutan with 
a human brain. The early drawings of 
Live Corp employees are a masterclass 
in generating many characters with 
different yet similar looks.

When you begin flicking through the 
production design chapter you find 
some real gems. Our favourites by far 
are the ingenious designs for 
Watermelophant, Shrimpanzees and 
Hippototamus – the latter having a 
blob of melted butter in its mouth, in a 
sketch by Craig Kellman. Amazing. 
Barry the strawberry is also pretty 
cool. Of course though, in the 
production design chapter you’ll also 
find delicious drawings of sumptuous 

TASTY CONCEPTS Go behind the scenes on the animation 
feature where ‘foodimals’ threaten to destroy civilisation

he original Cloudy with a 
Chance of Meatballs was  
a riot. Huge fun. And it 
looked brilliant, too. 

Sublime character design, quirky 
personalities played out through 
exquisite detail and a great overall 
look. The sequel looks just as fun, 
with the lead character Flint trying  
to stop his invention – The 
FLDSMDFR – creating ‘foodimals’ 
(animal and food hybrids) that 
threaten to destroy the world. 
Anyhow, there’ll be nothing to spoil 
your appetite for the film here. What 
we will share with you is the beauty 
of this book.

The tome is split into two main 
chapters: character design and 
production design. In the first chapter 
we’re given an introduction to the main 
characters in the movie – starting of 

T

The Art of Cloudy with a 
Chance of Meatballs 2

The visual development 
team consciously chose 
whimsy over physics to 
try and capture a sense 
of dreamlike adventure.

To jalapeño and back: Flint’s lab exterior colour  
key by artist and animator Seonna Hong.

worlds. From Pickle Village to 
Breakfast Bog, early and worked-up 
environmental sketches give you a real 
taste for the movie. Dynamic colour 
keys by Brandon Jeffords are 
particularly interesting.

In the foreword, Sony Pictures Digital 
Production president talks of the 
“undeniable charm, silly humour and 
eye-popping imagery” of the films and 
the book captures that perfectly. As if 
we haven’t stuffed enough food puns 
into this review, go buy this book if 
you’re a fan of production art. It’ll 
certainly satisfy your appetite for quite 
a while. Indeed, it’s absolutely delicious.

RATING  

Reviews
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Martin Deschambault 
explains how scenes 
such as this require 
film-style ‘takes’. 

Ivan Smirnov, who 
painted this cartoon 
environment, likes 
adding colour early on.

igital Painting Techniques 
hits Volume 5 and offers 
more of the same step-by-
step tutorials from artists 

around the world on different 
subjects. There’s something to be 
said for the simplicity of the design 
– the steps are easy to follow. 
However, the layout can feel slightly 
bland in places, even with a few 
paint-splattered tips boxes.

The book itself is divided neatly into 
four chapters: subjects, styles, 
techniques and the obligatory gallery. 

aargh! ’Tis a fine book. 
Sorry, we were just getting 
into character there after 
flicking through the feisty, 

fiery pages of this cutlass-sporting 
tome. Of course, it’s a behind-the-
scenes look at the artwork of the 
latest in the Assassin’s Creed series, 
but the truth is, if you love pirates, 
you’ll love this.

From the terrifying depiction of 
Blackbeard by ImagineFX favourite 
Raphael Lacoste, to the captivating 
environments by Grant Hillier, there’s 

Digital Painting Techniques: Volume 5

The Art of Assassin’s Creed IV: Black Flag

Author Various  Publisher 3D Total  Price £30  Web www.3dtotal.com  Available Now

Author Paul Davies  Publisher Titan Books  Price £30  Web www.titanbooks.com  Available Now

DIGITAL SKILLS Discover insider digital techniques from some  
top artists in this latest volume of 3D Total’s training books

ME ‘ARTY For all pirate and art lovers – not just video game addicts – 
this book of concept art is a real chest of secret treasures

Subjects cover weapon design, 
creatures from mythology, character 
portrayal and battle scenes. 
Workshops from Simon Kopp and 
Michal Lisowski run you through 
painting an alien-world scene and a 
street riot. These give nice start-to-
finish insight into the artists’ processes.

It’s the techniques chapter where the 
book becomes more interesting. 
Workshops on connecting using simple 

some stunning concept art from some 
of the world’s best within this luxury 
title. The map on the inside front and 
the metallic skull with spot varnish 
hiding under the cover add to the 
luxury, although it should do for £30.

Interesting historical info starts the 
chapters and the book takes a caption-
led approach, which enables the 
artwork to breathe and gives you some 
short, punchy quotes from the artists. 

D

A

brushes give a good introduction to 
roughing out form, and the aging 
materials section has some good 
advice on making your buildings and 
vehicles look older and worn. 

For £30 DPT Volume 5 is decent 
value and if you’re keen to discover 
techniques from brilliant artists it’s 
worth a flick before you commit.

RATING  

However, we’d like a little more 
information in some areas. Elsewhere 
you’ll find some detailed ship and 
weapon designs, and it’s always a 
pleasure to see Kobe Sek’s expressive 
concepts. Whether you’re a fan of the 
game or not, it’s a masterclass in game 
art. If you’re an Assassin’s Creed fan, it’ll 
be a doubly brilliant purchase.

RATING  
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New from ImagineFX! Pick up this special collector’s edition featuring the 
sketchbooks of some of the world’s best-known fantasy artists…

On sale now at WHSmith, Barnes & Noble, www.myfavouritemagazines.co.uk/design  

and for iPad at http://ifxm.ag/ipadifx

“Producing unique takes on creatures that have been produced a thousand 

cing unique takes on creatures
ing unique takes on creature

times is always a fun task”

have been produced a teen produced a t

HERMIT 
CRAB

“This is a fictional design that was meant to fit in with a personal project I never got around to finishing. It’s still on the back burner, mind. These crabs would continually grow with age – much like the giant tortoise.”

QUADRAPECK“Giant behemoth creatures always fascinate me, but I usually like them when they’re more grounded in reality. I loved the Oliphants created for The Lord of the Rings and the giant Hammerhead Titanothere in Avatar. This sketch was produced somewhere between the making of those two films.”

Be glad that you’re not living in a world populated by Mike’s imaginative collection of beasties and critters!

MMMMMiiiiiiikkkkkkkeeeee CCCCCCoooorrrrrrrrrrrriiiiiieeeerrrroooo PROFILE
Mike Corriero
COUNTRY: US

Mike is a freelance concept artist and illustrator for the video game and film 
industries. He’s produced work for companies such as Hasbro Inc, Paizo Publishing, Liquid Development, Radical Entertainment, Applibot Inc, Team Chaos and many more. Mike specialises in creature design and development, character design, environments and art direction. Check out his awesome work at the site below.

www.mikecorriero.com

ORNITHOPODS“It’s useful to produce your own take on extinct or prehistoric mammals and dinosaurs. In this case I was fooling around with fictional Ornithopods.”

TERRORBIRD “Extinct species of animals as well as existing species always play a big part in inspiring new ideas.”

BLIND
DRAGON“Producing unique takes on creatures that have been produced a thousand times is always a fun task. Here are a few smaller mole-inspired concepts before working up a blind dragon with anatomy inspired by the star-nosed mole and wings developed into additional digging limbs.”

22
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PROFILE
Hendrik Gericke

Based in Cape Town, South 

Africa, Hendrik is a self-

taught professional artist, 

choosing this career after 

purchasing his very first 

copy of 2000AD in 1995. Being South 

African to the core, growing up during 

the stormy 1980s and the major 

political transitions of the 1990s has 

played a major part in his development, 

both personally and as an artist.

hendrikgericke.blogspot.com

“Anatomy study is a 

constantly evolving subject Anatomy study ismy y

for me, because there a
re a constantly evolving subje

constantly evol g

million ways to approach it
”for me, because there a

e

When someone's willing to draw a superhero in an 

embarrassing situation, their art’s worth a closer look…

DEPOSITORY
“This is part of a set, which 

comprises loosely themed civic 

structures in a hypothetical (and 

very stylised) town.” 

LOAD
“I stole this idea from a 

Navy poster of a fully laden 

cartoon SEAL which reads 

‘The Only Easy Day Was 

Yesterday’. I live by 

these words.” 

SUIT 
“This is a loose sci-fi 

type scribble of a girl in a 

mech suit, if you can figure it 

out! There’s a finished digital 

wash version online if you 

care to go looking for 

it. Or drop me a line 

and I’ll send you 

the link.” 

TWIST 
“Anatomy study is a constantly 

evolving subject for me, because 

there are a million ways to approach 

it and you’ll probably never 

quite manage to pin it down. 

I try to keep it loose 

and uncomplicated.” 

BOOTH 
“This drawing was part of 

a set for a local university’s 

annual magazine. The theme 

was The Superhero, so I had fun 

with the old stereotypes.” 

SURGE 
“This is part of a set I 

made after seeing the first 

Transformers film. I was astonished 

at the complexity and energy on 

show and wanted to capture 

some of that.” 
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Hennnnnnnnndddddddddrrrriiiikkkkkkkkk GGGGGGGeeeeeerrrrriiiiiicccccckkkke

PROFILE

FAROUCHE
“I wanted to create a 

dream-like environment 
with this digital sketch.

Surrealism and a bit 
of an Art Nouveau 

influence were 
incorporated.”

Jennifer Healy
Jennifer’s elaborate 
illustrations first caught 
our attention way back in 
issue 82, where we 
crowned her our FXPosé Artist of the Month. Much of Jennifer’s style is founded on the storytelling qualities of colour, whether painting digitally or using traditional mediums. Music, fashion and melancholia often play an important role in her work. www.jennifer-healy.com

We’ve got a case of paramnesia, where our dreams are crossing over into reality  – and we like it

Jennnnnnnnnnnnnnnnniiiifffffffeeeeeerrrr HHHHHHHHeeeeeeaaaaaalllyyyyyyy
We’ve got a case of paramnesia, where our dreams

e’ve 
re m

MEMENTO 
MORI

“This portrait sketch was 
done in Photoshop. The 
fully painted version is a 

bit different and 
the concept 

changed slightly.”

“I like to put my designs together like this – it 
e to put my desigp t my desig

makes it easier to decide 
g e like this  it ke this  

which one to work on first”

VINTAGE SEA
“This digital sketch has some sea-like elements mixed into the design. This sketch represents a more fashion-like concept.” 

CHOICES
“These digital sketches were done in Photoshop, mostly consisting of surrealism and fashion designs. I like to put them all together like this – it makes it easier to decide which one 

to work on first.”
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Where great art begins...

180
PAGES  OF ARTIST SKETCHES!



Publisher Gurney Studio  Price $32 (DVD), $15 (download)  Web www.jamesgurney.com/site/videos

ARTIST PROFILE

JAMES
GURNEY

Best known for his book series 
Dinotopia, James specialises in 
realistic images of scenes that 
can’t be photographed, from 
dinosaurs to ancient civilisations. 
James taught himself to draw  
by reading books about Norman 
Rockwell and Howard Pyle.  
He received a degree in 
anthropology at the University of 
California at Berkeley, but chose 
a career in art. As well as the 

Dinotopia series, 
James has written 
instruction books, 
Imaginative Realism 
and Color and Light.

www.gurneyjourney.blogspot.com

instruction rather than training and 
what you’ll get from this video is an 
overview of the process, rather than 
the full-on details on how to execute  
it yourself. But his process is so 
meticulous that getting into the artist’s 
mind through this video can’t help  
but encourage you to invest more  
in your own work.

The earlier How I Paint Dinosaurs 
release is arguably better value, 
showing two full projects in 53 minutes 
rather than the one project here. But 
it’s hard to quibble with a film that 
charms and entertains as much as it 
informs, with high-quality editing and 
presentation throughout. 

The download version is a 
sumptuous 1080p presentation, 
although its 1.6GB could take you a 
little while to download. The DVD 
version is nearly double the length of 
the download, with a selection of 
extras that includes an excellent look  
at the evolution of James’ famous 
Dinotopia franchise. 

SHORT AND SWEET James Gurney offers a brief but nevertheless 
rewarding look into a demanding natural history project

ard on the heels of James 
Gurney’s superb How I 
Paint Dinosaurs (reviewed 
in issue 102) comes this 

look at how the master illustrator 
researched, planned and painted a 
beautiful set of stamps for Australia 
Post. The video’s quite a brief watch 
at 38 minutes, but it covers a lot of 
ground in that time.

You’ll see, for example, the work 
James puts into research, making sure 
his versions of these long-extinct 
creatures adhere to the latest scientific 
thinking of how they looked and 
behaved. The video also shows every 
stage of creating the artwork, including 
building reference maquettes and 
trying out colour schemes, as well as 
offering an insight into planning a 
composite image, where each stamp 
works as a self-contained piece of art, 
while also fitting together to form a 
larger, whole scene.

James calls the approach of 
Australia’s Age of Dinosaurs art 

H

Australia’s Age of Dinosaurs

James’ dinosaurs are a composite painting: 
cleverly the stamps work as a collective 
image but also as stand-alone images.

James Gurney was 
asked to paint dinosaur 

art for Australian 
postage stamps.

Inspiration Training

February 2014 97

Topics covered
Fossil study

Research in the bush

Building reference

models

Concept sketches

Painting the canvas

Paleontology 

interview (DVD only)

The making of 

Dinotopia (DVD only)

Length
72 minutes (DVD), 38 

minutes (download)

Rating

DOWNLOAD RESOURCES http://ifxm.ag/oolala105
Video sample
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Foreshorten the figure.

114 First Impressions
Greg Hildebrandt isn’t satisfied.

99February 2014

INSPIRATION AND ADVICE FROM THE WORLD’S BEST TRADITIONAL ARTISTS

This issue:



IMAGINEFX CRIT
“I never thought 
I’d empathise 
with a dragon, 

but Lucas’s wintery 
scene gives the fire-
breather a quiet, calm, 
almost vulnerable 
character in his freezing 
surroundings. Legacy is 
equally full of feeling.” 
Beren Neale,
Digital Editor

Lucas Durham 
LOCATION: US
WEB: www.lucasdurham.com
EMAIL: lucasdurham1000@gmail.com 
MEDIA: Watercolour, gouache, oils

It was at the Florence 
Academy of Art that Lucas 
first began merging 
classical techniques with 
modern sci-fi and fantasy 

narratives. The US artist, a graduate of 
the American Academy of Art, travelled 
to Italy as an exchange student and fell in 
love with Renaissance and Baroque art.

“I consider myself fortunate to be 
part of the sci-fi and fantasy art 
community, where mentors 
continuously challenge me to cultivate 
my skills,” says Lucas.

The Chicago-based freelance 
illustrator began his career creating 
concepts for collectibles company the 
Bradford Exchange, before moving into 
card game and literary art.

1  LEGACY
Watercolour and gouache  

on board, 16x25in 
“Shortly before going to the 2013 
Illustration Master Class, my paternal 
grandfather died. This is an homage to 
birthrights passed from fathers to sons. 
It’s my largest watercolour painting.”  

2  WINTER DRAGON 
Watercolour and gouache  

on board, 17.75x23.5in  
“I grew up in a house full of prints by the 
naturalist, Robert Bateman. This 
painting is inspired by the artist’s 
technique of depicting animals and 
environments with equal emphasis in 
his compositions.”
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FXPosé

FXPosé submissions to: fxpose@imaginefx.com
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1Erik Gist
LOCATION: US
WEB: www.erikgist.com
EMAIL: emgist@erikgist.com
MEDIA: Oils

It’s not hard to see why Erik 
is such an in-demand artist. 
The California-based 
freelancer has a portfolio 
full of gloriously macabre, 

highly inventive artwork, which has 
found clients in the likes of Wizards of 
the Coast, DC Comics and Blizzard 
Entertainment, to name just a few. 

His work can be seen adorning the 
cover of Dark Horse Comics’ adaptation 
of Guillermo del Toro and Chuck 
Hogan’s vampire novel series The 
Strain, and the forthcoming Aliens vs. 
Predator title. 

Erik studied with acclaimed artist Jeff 
Watts before going on to become a lead 
instructor at his school, Watts Atelier of 
the Arts. Working in the video game 
industry as a concept designer, 3D artist 
and as an illustrator, he’s picked up 
nominations for the Illie Award and 
Chesley Award, and has won the Horror 
Comics Award. 

1  THE FALL #2
Oil on gessoed hardboard, 14x22in

“I met Guillermo del Toro at a horror 
convention a couple of years back. He 
liked my work and recommended me as 
the cover artist on the comic adaptation 
of his novels The Strain.”

2  LAST CHARGE 
Oil on gessoed hardboard, 18x24in

“A little while back I was hired by Green 
Ronin Publishing to do a cover for its 
Dragon Age pen-and-paper RPG. The 
description I was sent reminded me of 
one of my favourite scenes in The Two 
Towers, and so I set about doing my 
version of Theoden’s charge.”

102 February 2014

FXPosé

FXPosé submissions to: fxpose@imaginefx.com

Send up to five pieces of your 
work, along with their titles, an 
explanation of your techniques, a 
photo of yourself and contact 
details. Images should be sent as 
300DPI JPEG files. 

Email: fxpose@imaginefx.com 
(maximum 1MB per image) 

Post: (CD or DVD):  
FXPosé Traditional
ImagineFX
30 Monmouth Street
Bath 
BA1 2BW, UK

All artwork is submitted on the 
basis of a non-exclusive 
worldwide licence to publish, both 
in print and electronically. 

SUBMIT YOUR 
ART TO FXPOSÉ



2

IMAGINEFX CRIT
“If Guillermo del 
Toro’s a fan of 
your stuff, you 

know you’re doing 
something right. Dark, 
dynamic and full of 
character, Erik’s is some 
of the most captivating 
trad work around.” 
Gary Evans,
Staff Writer
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ART MACABRE:  
LONDON

Sounding the death knell for dull drawing groups everywhere,  
ART MACABRE was founded to make a morbid spectacle of still life

Art Macabre meets at 
different venues, such as 
Barts Pathology Museum.

W
alking cadavers. 
Hitchcockian birds  
in gilded cages.  
A whodunit hosted 
by film-noir inspired 

femme fatales. Art Macabre is nothing  
if not adventurous. 

The London-based salon was founded 
to “inject a lethal dose of theatricality and 
the macabre” into art groups. Each meet 
has a new theme and setting, with 
costumes, props and multimedia tools. 
And nudity. Lots of nudity. 

“There’s a tradition of the nude form,” 
says founder Nikki Shaill, “contrasted 
with skeletons, skulls and symbols of 
mortality. Memento mori artwork assists 
people in reflecting on the beauty yet 
fragility of life. We aim to update 
this tradition, with a twist.”

Back in 2010, Nikki ran a 
special Halloween edition 
of her more traditional art 
group. It proved so 
popular she decided to 
pursue the death-drawing 
theme, and Art Macabre 
was born. Past events have 
had titles such as Midsummer 
Night’s Scream, Kiss of Death and 
Hot Cross Bunny Boilers.

The sessions are open to all, with the 
aim of helping people gain confidence in 
mark making, developing their skills and 
“pondering death in a different way.”

Death Drawing has gone from strength 
to strength, with a string of future events 
lined up in and around London, but it’s 
with some trepidation Nikki welcomes a 
landmark on the horizon. “I’ve said that 
I’ll take the plunge and pose nude for the 
very first time at Art Macabre’s 100th 
event. Which I may regret, as it is 
approaching quite swiftly.”
Go to www.deathdrawing.com for more and 
follow @ArtMacabreLDN. 
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Do you
want your school

or art group  
featured here? Email 
mail@imaginefx.com

and we’ll do  
the rest!



A DYING
ARTAA

A selection of deadly drawings from  
Art Macabre sketch groups

At Art Macabre’s 100th meet 
founder Nikki Shaill has 

pledged to life model.

Facing death: one of the founding 
ideas behind Art Macabre is to 

encourage artists to “ponder 
death in a different way”.

Aaron Jacob 
Jones’s rendering 
of Lorraine of 
Terror, drawn  
at the Horror 
Hospital special.

Aaron Jacob 
Jones switches 
to red ink for 
this sketch, also 
from the Horror 
Hospital event.

Models are 
invited to 
choose the 
music that 
accompanies 
their session.

All models  
use makeup, 
costumes and 
props to bring 
each theme  
to life. 

Materials are provided for each session, 
making the events accessible to artists  
of any standing. 

Morbid fantasy: yep, it’s safe 
to say Art Macabre is not 

your typical sketch jam.
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PAINTING AGAINST A 
DARK BACKGROUND

KEV CROSSLEY breaks out the easel, brushes, pencils and paints,  
and tackles a classic pulp fantasy composition with a twist

F
or this painting I wanted to pay 
homage to the classic fantasy 
compositions I loved as a kid. 
The image of a lone hero 
battling atop a mound of fallen 

foes is perhaps the principal cliché of 
fantasy art. But the dramatic potential is 
huge and besides, it’s great fun to draw!

I was also inspired by the Pre-
Raphaelites, in particular John William 
Waterhouse and the infamous Baroque 
painter Caravaggio. They utilised dark 
background colours to contrast against 
the pale skin tones of their subjects with 
striking effect.

While still at school, I taught myself 
how to paint using watercolours and 
coloured inks. I never received any formal 
instruction, so I had to work out the 
rhythm and flow of the medium by trial 
and (much!) error. The looseness and 
versatility of the paint when applied in 
wet washes was endlessly rewarding. 
Complex colour planes could be built up 
by layering consecutive translucent 
washes, and I enjoyed how the wet paint 

sometimes dried to leave abstract marks 
and patterns. However, because of the 
transparent nature of watercolour it isn’t 
practical to paint light over dark, and this 
became a limiting factor when I sought to 
emulate the oil paintings of the old artists 
who inspired me so much. I began to use 
the paint thick, straight from the tube 
with little water, but watercolours simply 
aren’t intended to be used in this way: the 
colours become lifeless and flat.

It was during this time that fully 
painted art began to appear in sci-fi/
fantasy comic 2000 AD. I discovered 
acrylics were the medium most frequently 
used, so I bought my first set and began 
the long process of teaching myself to use 
them. I found I was able to get closer to 
that classic fantasy art feel, but I haven’t 
put away the watercolours for good.

A common practice among oil painters 
involved producing a watercolour sketch 
of a painting before starting work on the 
final oil version. The artist would 
experiment with the colour palette and 
tone balance, saving time later on. 

 After 15 years designing video 
games, Kev turned freelance, 
illustrating monsters and 
warriors for gaming books, 

working for 2000 AD and various US 
publishers. He also provided writing and art 
for books, and in 2012 illustrated Ian 
Livingstone’s 30th anniversary Fighting 
Fantasy title, Blood Of The Zombies.  
www.kevcrossley.com

MATERIALS

SURFACE

 Heavy textured 

art-board 

 Watercolour paper

PENCILS 

 Orange Col-Erase,  

2H and HB

BRUSHES

 Watercolour brushes

 Toothbrush to add  

texture

PAINTS

 Blue, green and red 

watercolour

 White ink for

highlights

 Glazing medium

AcrylicsWatercolour

DOWNLOAD RESOURCES http://ifxm.ag/oolala105
WIPS • FINAL IMAGE
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1 Initial sketches
Sketching helps you define what 

your composition and the characters 
within it will look like, so it’s worth taking 
the time to explore a few different ideas. 
Here’s the final sketch I decide to use, 
along with an alternative concept.

2 Character ideas
I opt for mutant ant women as 

my horde, but it takes me a while to 
settle on a tarantula head (or is it a 
helmet?) for the barbarian. Here’s a 
selection of sketches exploring ideas 
for the characters.

3 Finished pencils
After I’ve rendered the finalised 

version of my pencil drawing on heavy 
textured art-board, using orange Col-
Erase, 2H and HB pencils, I produce a 
smaller, simplified duplicate on lighter 
watercolour paper using a 2H and an 
HB Rotring automatic pencil. 

4 Watercolour and tone
For my watercolour sketch, I start with a watery black wash 

to work out how the dark areas might look. I apply consecutive 
washes over the same areas after the previous washes have dried, 
to build up the tone study.

5 Colour wash
Next, I apply light washes of 

colour over the pencils. I use a range of 
blues and greens for the ant women, 
with a fleshier tone for the barbarian.  
I lay down a red wash and use a finer 
brush to create contrast.  

ARTIST INSIGHT
USE WATERCOLOUR 
PAPER FOR EFFECTS

You can create

interesting structural

effects using textured

watercolour paper,

which is available in 

a range of weights  

and colours.

6 Digital tweaks
Here you can see the finished version of the watercolour.  

I use white ink to enhance the lighter areas and create highlights, 
and do a few tweaks in Photoshop on the scanned image.  
I adjust the colours and also produce a stylised tone study.

108 February 2014
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Digital tweaks6

109February 2014

In depth Dark background



9 Lighter tones
To develop the underpainting  

I use white to enhance the lighter 
areas, which greatly improves the 
dynamic drama. Then I finish with 
more dark washes, and a final glaze  
of light ochre to knock the harsh white 
paint back a touch.

7 Acrylics and tone
This is the end of the 

watercolour sketch stage – a 
preliminary study for reference. I now 
redraw the final acrylic painting from 
scratch on art board. The first stage 
echoes the watercolour stage. I create 
a wash of black and carefully paint 
over shadows and dark areas. I repeat 
the process to build the tones and use 
a toothbrush to add texture.

10 Ant women colours
I don’t want to overwork the 

colours though, so here I adopt a 
textural, impressionistic style to add 
dabs and washes of blues and greens 
over the bodies of the ant women.  
By doing this I’m enabling the  
reddish tones of the under-painting  
to show through.

8 Apply a colour glaze
I mix a glaze by adding water 

and paint to a glazing medium, which 
helps delay the drying process. I use 
reddish brown to add depth to the 
blacks, and apply the glaze irregularly 
for extra textural interest.

PENCIL TIP
LOAD YOUR LEAD

2H is good for fine line
work. HB is good for

strengthening 2H lines.
2B to 6B are soft and
good for large areas 

of dark tone.

Ant women colours 10

ARTIST INSIGHT

USING A GLAZE

Applying a translucent 

coloured glaze over an

acrylic or oil painting 

helps to balance 

colours and smooth  

out tonal variations. 
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ARTIST INSIGHT
DIGITAL COLOUR 
BALANCING

Using Photoshop to

adjust the colours,

balance and saturation

of a scanned painting is

the digital equivalent  

of using glazes!

12 Background
I create a sense of depth by breaking into the dark 

background with lighter shades, dabbed on with a dry brush.  
I use reds and pale yellows to enliven the region around the 
characters, with the toothbrush providing additional texture.

13 Finishing up 
I paint trickles of red and other texture details over the bodies of the 

characters, using a very fine brush. I add more toothbrush spatter in varying hues 
over all parts of the image, and then I call the painting finished. 

11 Barbarian colours
I use a similar approach when 

adding colour to the barbarian. Too 
much intensive over-painting would 
cover much of the tonal work, so  
I apply the colour in thin washes, with 
thicker hues in specific areas.

BRUSH TIP
SIZING UP

Use large, wide brushes
to build tone or colour. 
Size 3 or 6 is suitable for
most painting work, 00

to 0000 (tiny!)  
for detail.

Background12

Finishing up 13
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FORESHORTEN  
THE FIGURE

Anatomy expert CHRIS LEGASPI presents his tried and tested strategies  
for achieving accurate foreshortening in figure drawing

MATERIALS

 Smooth newsprint

paper

 Carbothello pencil, 

black (or Conte’ B) or

Willow charcoal sticks 

(medium grade)

 Kneaded eraser

 Ballpoint pen

 Sketchbook

U
sing good observation and 
simple strategies, achieving 
proportionally accurate 
perspective can be simple 
and fun. I first see the figure 

as simplified geometric forms. The most 
useful form for describing perspective is 
the cylinder, because it’s both round and 
straight in character. As such, it’s ideal for 
describing the position of a form.

Position is where a form is in three-
dimensional space. The keys to position 
are direction and eye-level. Direction 

refers to which way the form is moving, 
while in terms of eye-level, I can either be 
above or below the form.

The primary tools I use to achieve 
perspective are tapering cylinders, cross-
sections and overlaps. A tapering cylinder 
both mimics the natural forms of the 
body and also suggests perspective. Cross-
sections are the curved lines that segment 
a cylindrical form. If my eye-level is below 
the form, then my cross sections will 
curve up, and vice versa. The exceptions 
to this rule are when the form moves 

toward or away from me in perspective.  
In either case careful observation of the 
direction is the key.

I use overlaps to achieve deep 
perspective. I’ll often exaggerate existing 
overlaps or sometimes create my own. 
This gives me one more layer of depth 
that really helps to push the illusion of 
foreshortened, three-dimensional form.

 Chris is keen to share his 
knowledge of art theory. You 
can see more of his work at 
www.freshdesigner.com.

1 Note the 
direction

Forms, like the limbs, can 
move in any direction. To 
achieve believable 
foreshortening, I must first 
observe the direction  
of the form before 
beginning my drawing.

2 Start with the joints
To begin the drawing, I establish the location of the joints, 

especially the shoulders and hips. This gives me a more accurate 
gauge of the correct distance when a form is foreshortened.

Ballpoint penPencil

Up and away

Along 
and  
away

Direction 
change

When forms are
generally straight 
and move in one 

direction, use 
the entire 
length of  

the form to 
measure one

The natural 
distance/length
remains unaltered
when there’s
little to no 
perspective

Use the entire
length of forms
for accurate
measurements

Down and
towards

Down and
away

Charcoal

Ends of  
form are 

also distance 
markers

Distance becomes 
altered (shortens)

when forms 
move into deep 

perspective

112 February 2014

Workshops



3 Tapering cylinders
Cylinders are a useful shape for 

describing perspective. Tapering 
cylinders are better, though, because 
they quickly suggest perspective, 
especially forms that are moving away. 
They also mimic the way organic 
forms naturally bulge and taper.

4 Cross-sections
I use cross-sections to not only 

describe the nature of the form, but 
more importantly to establish eye-
level. If my eye-level is beneath a form, 
I make the cross-sections curve up. 
When I’m above a form, I’ll make the 
cross-sections curve down. 

5 Overlaps for depth
To achieve greater 

depth and foreshortening,  
I look for opportunities to 
overlap forms. I like to either 
exaggerate existing overlaps 
or create my own. Overlaps 
along with tapering cylinders 
help to push the perspective 
and three-dimensional quality 
of a form. 

EXERCISE
FORSHORTENING

Draw 10-20 form studies 
from life. Spend 10-20

minutes per drawing and
focus on perspective 
and foreshortening. 

Even unusual 
forms like the 
palm of the 
hand can be 
described as 
a tapering 
cylinder

Ending a form with a simple 
taper can quickly indicate
the perspective

Neutral cross- 
sections equals 
no perspective

Cross-sections curving 
down also describes 
forms moving up 
and away

Cross-sections curving up also 
describes forms that are 
moving down and towards

Bulge

Bulge

Pinch
Pinch

Exaggerate overlaps
for deep perspective

Construct the
torso in sections
to create overlaps

1

2
3

Find opportunities
to ‘force’ overlaps
to heighten the
foreshortening

ARTIST INSIGHT

INSTINCTIVE ART

Start with gesture and 

use your instincts to 

judge the length of 

foreshortened forms.  

With practice, your 

proportions will 

improve and your 

figures will be both 

accurate and life-like.
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Cross-sections
curving down

equals
eye-level

above form

Cross-sections
curving up

equals
eye-level

below form

Artist insight Foreshortening



What do you consider to 
be the first pin-up image 
you created, and why do 
you think you are drawn 
to paint women? 

The first painting I did in my American 
Beauties series of 40s-50s pin-ups is 
called Emerald Evening. Why I paint 
women is an interesting question and 
the answer is so simple: they are 
beautiful and I love to paint beauty.

Which pin-up artist was your first 
artistic crush on and why?
Gil Elvgren. As a young boy of eight  
I saw my first Elvgren pin-up calendar in 
my grandfather’s basement. I had no real 
clue what I was looking at, but I knew it 
was amazing.

Do you have a ritual for when you start 
a painting?
If you are asking me if I have to chant 
before I paint, the answer is no. If you are 
asking me my process, that’s a different 
story. I do multiple rough sketches before 
I choose a pose. Then I get a model and 
take my photos of her in costume. Then I 
do my finished sketch that I’ll transfer to 
canvas. Then I sit down, mix my paint 
and begin.

When did you first realise you wanted 
to be an artist?
I guess I never realised I wanted to be an 

artist. Art chose me, I did not choose it. 
My earliest memory of doing art was at 
three years old. My mother told me years 
later that my brother and I were 
colouring in the lines at three. She said 
she was amazed at the fact we would sit 
for hours at that age and never get bored 
of colouring. 

Do you remember the first image that 
made you think you’d nailed it?
Unfortunately, I will be 75 in January, 
and I’ve not nailed it yet. But I keep 
trying. As far as pieces I’m really happy 
with there are a few of my American 
Beauties that I’m very partial to: Emerald 
Evening, Hotel Nights, Ledge, Lady in 
Red, Yellow Rose of Texas, Made in the 
USA, Hot Rear Ends, American Beauty, 
Lipstick, Casting Couch, Science Gone 
Wild, Grease Monkey, Sudden Danger, 

Mad Science, Saturday Night Special, 
Double Vision, and Smooth and Sensual.

What was your first pin-up commission?
I started the American Beauties series 
for myself in 1999. The first pin-up 
commission I did for a client was in 2009 
and it was called Thoughts of Midnight. 
I painted a girl on the nose of a 1943 
P-38 Lightning WWII aeroplane, for a 
collector of WWII warbirds in Texas.

What was the first bit of praise that you 
received that spurred you on? 
After I finished Emerald Evening my 
agent contacted Lou Meisel. He wrote the 
book The Great American Pin-up. He 
knew my fantasy art. When he saw my 
first piece he said it was amazing, and the 
next thing I knew I had a one-man show 
planned at his SoHo gallery. All I painted 
for a year was pin-ups for that show.

And your first knock-back?
I don’t want to sound like a jerk, but  
I really can’t remember one. There were 
always changes that clients wanted and 
you made them. That was my job and  
I did it. If anything, I was never satisfied 
with anything I ever did artistically. 
That’s what kept me going all my life.

What advice would you give to artists 
starting out?
Never quit. Never pay any attention to 
criticism unless it’s constructive. Learn 
something new every day of your life.  
Be passionate about your art and always 
give 1,000 per cent of your capability  
to what you’re working on.

Who’s the first artist that you turn to  
for inspiration?
I could list them but I would take up 
your magazine. They stretch through 
time and through genres and through 
mediums and each one is a gift.

If you could go back to the start of your 
career, would you change anything?
No.

What was the last pin-up image you 
painted, and were you happy with it?
The last painting I completed was last 
week and is called Going My Way. And 
yes, I am happy with it.
You can see more of Greg’s work at  
www.americanbeautiesart.com 

 I was never satisfied with 
anything I ever did artistically. 
That is what kept me going 

DOUBLE VISION
Luxury cars and glamorous 
models have long been used in 
advertising imagery, but Greg’s 
pin-up artwork takes the concept 
to the next level.

EMERALD EVENING
This image is part of Greg’s 

American Beauties series, and 
is one of the artist’s favourites. 
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Greg says he hasn’t 
nailed a painting yet. 
We respectfully beg 

to differ…

First Impressions
Greg Hildebrandt

LOOKING FOR 
THIS ISSUE’S 
RESOURCES?

6
SEE PAGE





90
00

90
01


